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Q.1 ଦୁଇଟି କ୍ରମିକ ଧନାତ୍ମକ ପୂର୍ଣ୍ଣସଂଖ୍ୟାର ଗୁଣଫଳ 1332 ଅଟେ । ଯଦି ଏହି ଦୁଇଟି ପୂର୍ଣ୍ଣ ସଂଖ୍ୟା ମଧ୍ୟରୁ  କ୍ଷୁଦ୍ରତମ
ସଂଖ୍ୟାକୁ x ଦ୍ୱାରା ଦର୍ଶାଯାଏ, ତେବେ x ର ମୂଲ୍ୟ ବାହାର କରିବା ପାଇଁ  ସମୀକରଣ ସହ ନିମ୍ନଲିଖିତ କେଉଁ  ବିକଳ୍ପ
ମେଳ ଖାଇବ?

Ans A. x2 + x − 1332 = 0

B. x2 − x + 1332 = 0

C. x2 − x − 1332 = 0

D. x2 + x + 1332 = 0

Question Type : MCQ
Question ID : 4410091220360
Option 1 ID : 4410094814863
Option 2 ID : 4410094814866
Option 3 ID : 4410094814865
Option 4 ID : 4410094814864

Status : Answered
Chosen Option : D

Q.2 ଦୁଇଟି ପାଇପ ଗୋଟିଏ ଟାଙ୍କିକୁ ଯଥାକ୍ରମେ 18 ମିନିଟ ଓ 27 ମିନିଟରେ ପୂର୍ଣ୍ଣ କରିପାରିବେ । ଯଦି ଉଭୟ
ପାଇପକୁ ଏକାଠି ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି  ପୂର୍ଣ୍ଣ ହେବା ପାଇଁ  ଲାଗୁଥିବା ସମୟ କେତେ?

Ans A. 10 ମିନିଟ

B. 10.25 ମିନିଟ୍

C. 10.8 ମିନିଟ

D. 9.6 ମିନିଟ

Question Type : MCQ
Question ID : 441009167642
Option 1 ID : 441009663685
Option 2 ID : 441009663683
Option 3 ID : 441009663684
Option 4 ID : 441009663686

Status : Answered
Chosen Option : D

Q.3 A ଏବଂ B ଏକ ବ୍ୟବସାୟରେ ପ୍ରାରମ୍ଭରେ 12 : 13 ଅନୁପାତରେ ନିବେଶ କରିଥିଲେ ଏବଂ ସେମାନଙ୍କର ଲାଭର
ଅନୁପାତ 6 : 13 ଥିଲା । ଯଦି A ତାଙ୍କ ଟଙ୍କାକୁ 9 ମାସ ପାଇଁ  ନିବେଶ କରିଥିଲେ ଏବଂ B ତାଙ୍କ ଟଙ୍କାକୁ x ମାସ
ପାଇଁ  ନିବେଶ କରିଥିଲେ, ତେବେ x ର ମୂଲ୍ୟ କେତେ ଅଟେ?

Ans A. 9

B. 12

C. 15

D. 18

Question Type : MCQ
Question ID : 441009896509
Option 1 ID : 4410093540106
Option 2 ID : 4410093540107
Option 3 ID : 4410093540108
Option 4 ID : 4410093540109

Status : Answered
Chosen Option : D
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Q.4 ΔUVW ଏବଂ ΔXYZ ନାମକ ଦୁଇଟି ସଦୃଶ ତ୍ରିଭୁ ଜର ବାହୁମାନଙ୍କର ଅନୁପାତ 7 : 8 ଅଟେ । ΔUVW ର
କ୍ଷେତ୍ରଫଳ 245 cm2 ଅଟେ । ΔXYZ ର କ୍ଷେତ୍ରଫଳ (cm2 ରେ) କେତେ?

Ans A. 280

B. 300

C. 230

D. 320

Question Type : MCQ
Question ID : 441009621054
Option 1 ID : 4410092438350
Option 2 ID : 4410092438351
Option 3 ID : 4410092438348
Option 4 ID : 4410092438349

Status : Answered
Chosen Option : C

Q.5 ଗୋଟିଏ ଗାଁ ର 96% ଜନସଂଖ୍ୟା 22800 ଅଟେ । ତେବେ ଗାଁ ର ମୋଟ ଜନସଂଖ୍ୟା କେତେ ଅଟେ?

Ans A. 32006

B. 24686

C. 25390

D. 23750

Question Type : MCQ
Question ID : 441009857542
Option 1 ID : 4410093383143
Option 2 ID : 4410093383141
Option 3 ID : 4410093383142
Option 4 ID : 4410093383140

Status : Answered
Chosen Option : B

Q.6 ଏକ ବୃତ୍ତ ଉପରେ ଚାରୋଟି ବିନ୍ଦୁ A, B, C, D ଏପରି ଭାବରେ ଅବସ୍ଥିତ ଯେ ABCD ଏକ ଚତୁର୍ଭୁ ଜ, ଯେଉଁ ଥିରେ
AC ଏବଂ BD ଦୁଇଟି କର୍ଣ୍ଣ ଅଟନ୍ତି ଏବଂ ∠ABC = 87°, ∠ACB = 23° ଅଟେ । ∠BDC ର ମୂଲ୍ୟ ନିର୍ଣ୍ଣୟ କର
।

Ans A. 81°

B. 51°

C. 68°

D. 70°

Question Type : MCQ
Question ID : 441009601258
Option 1 ID : 4410092360149
Option 2 ID : 4410092360152
Option 3 ID : 4410092360151
Option 4 ID : 4410092360150

Status : Answered
Chosen Option : C
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Q.7 ଦୁଇଟି ଟ୍ରେନ ସମାନ୍ତର ଧାରଣାରେ ପରସ୍ପରର ବିପରୀତ ଦିଗରେ ଗତି କରୁ ଛନ୍ତି । ଟ୍ରେନ A ର ଦୈର୍ଘ୍ୟ 90 m
ଏବଂ ଏହାର ବେଗ 54 km/h ଅଟେ । ଟ୍ରେନ B ର ଦୈର୍ଘ୍ୟ 60 m ଅଟେ । ସେଗୁଡିକ ପରସ୍ପରକୁ 6 ସେକେଣ୍ଡରେ
ଅତିକ୍ରମ କରନ୍ତି । ଟ୍ରେନ B ର ବେଗ km/h ରେ ନିର୍ଣ୍ଣୟ କର ।

Ans A. 48 km/h

B. 72 km/h

C. 60 km/h

D. 36 km/h

Question Type : MCQ
Question ID : 4410091419332
Option 1 ID : 4410095606252
Option 2 ID : 4410095606254
Option 3 ID : 4410095606253
Option 4 ID : 4410095606251

Status : Answered
Chosen Option : A

Q.8 ଯଦି k ର 25% ର ମୂଲ୍ୟ 15 ର 3600% ର ମୂଲ୍ୟ ଠାରୁ  10 କମ ହୁଏ, ତେବେ k ର ମୂଲ୍ୟ କେତେ ଅଟେ?

Ans A. 2120

B. 2080

C. 2160

D. 2100

Question Type : MCQ
Question ID : 4410091107655
Option 1 ID : 4410094367614
Option 2 ID : 4410094367616
Option 3 ID : 4410094367617
Option 4 ID : 4410094367615

Status : Answered
Chosen Option : C

Q.9 40 kg, 49 kg, 57 kg, 67 kg ଓ 36 kg ଓଜନ ଥିବା ପାଞ୍ଚ ଜଣ ସଦସ୍ୟ ବିଶିଷ୍ଟ ପରିବାରର ହାରାହାରି ଓଜନ
(kg ରେ) କେତେ ଅଟେ?

Ans A. 50.8

B. 48.8

C. 51.8

D. 49.8

Question Type : MCQ
Question ID : 441009272600
Option 1 ID : 4410091058948
Option 2 ID : 4410091058949
Option 3 ID : 4410091058950
Option 4 ID : 4410091058947

Status : Answered
Chosen Option : C
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Q.10 ଯଦି ଜଣେ ବିକ୍ରେତା ତାଙ୍କ ସାମଗ୍ରୀର ଅଧା ଅଂଶକୁ 25% କ୍ଷତିରେ ଏବଂ ଅବଶିଷ୍ଟ ସାମଗ୍ରୀକୁ 60% ଲାଭରେ ବିକ୍ରି
କରନ୍ତି, ତେବେ ସମଗ୍ର କାରବାରର ଲାଭ ପ୍ରତିଶତ ନିର୍ଣ୍ଣୟ କର ।

Ans A. 17.5%

B. 19.8%

C. 21.7%

D. 13.4%

Question Type : MCQ
Question ID : 441009900356
Option 1 ID : 4410093555495
Option 2 ID : 4410093555494
Option 3 ID : 4410093555497
Option 4 ID : 4410093555496

Status : Answered
Chosen Option : B

Q.11

ସରଳ କର:

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009575992
Option 1 ID : 4410092259091
Option 2 ID : 4410092259088
Option 3 ID : 4410092259089
Option 4 ID : 4410092259090

Status : Answered
Chosen Option : D
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Q.12 ପାଇପ A ଏବଂ ପାଇପ B ଏକ ଟାଙ୍କିକୁ ଯଥାକ୍ରମେ 6 ଘଣ୍ଟା ଏବଂ 10 ଘଣ୍ଟାରେ ପୂର୍ଣ୍ଣ କରିପାରନ୍ତି । ଉଭୟ
ପାଇପକୁ ଏକାଠି 3 ଘଣ୍ଟା ପାଇଁ  ଖୋଲାଯାଏ, ଯାହା ପରେ ପାଇପ A କୁ ବନ୍ଦ କରାଯାଏ ଏବଂ ପାଇପ B ଏକାକୀ
କାର୍ଯ୍ୟ ଜାରି ରଖେ । ତେବେ ଟାଙ୍କିଟି ମୋଟ କେତେ ଘଣ୍ଟାରେ ସମ୍ପୂର୍ଣ୍ଣ ଭାବେ ପୂର୍ଣ୍ଣ ହେବ?

Ans A. 6

B. 7

C. 4

D. 5

Question Type : MCQ
Question ID : 441009899765
Option 1 ID : 4410093553132
Option 2 ID : 4410093553130
Option 3 ID : 4410093553133
Option 4 ID : 4410093553131

Status : Answered
Chosen Option : A

 

Q.13 ଏକ କାର ଉତ୍ପାଦନକାରୀ କମ୍ପାନୀ ବର୍ଷସାରା ବିକ୍ରି ହୋଇଥିବା କାରର ଗୁଣବତ୍ତା ବିଷୟରେ ଶୋ’ରୁ ମ ଦ୍ୱାରା ପ୍ରାପ୍ତ
ଅଭିଯୋଗ ସଂଖ୍ୟା ବିଶ୍ଳେଷଣ କରିବାକୁ ଆଗ୍ରହୀ ଅଟେ । 10 ସପ୍ତାହ ଅବଧିର ରେକର୍ଡଗୁଡ଼ିକ ନିମ୍ନଲିଖିତ
ସାରଣୀରେ ଦର୍ଶାଯାଇଥିବା ତଥ୍ୟ ପ୍ରଦାନ କରେ ।

ସପ୍ତାହ ସଂଖ୍ୟା 1 2 3 4 5 6 7 8 9 10

ଅଭିଯୋଗ ସଂଖ୍ୟା 8 11 14 18 22 9 8 6 13 2

ସାରଣୀର ନମୁନା ମଧ୍ୟମା ନିର୍ଣ୍ଣୟ କର ।

Ans A. 10

B. 9

C. 12

D. 11

Question Type : MCQ
Question ID : 441009951759
Option 1 ID : 4410093760431
Option 2 ID : 4410093760433
Option 3 ID : 4410093760432
Option 4 ID : 4410093760434

Status : Answered
Chosen Option : A
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Q.14 ଜଣେ ନାଉରିଆ ସ୍ରୋତର ପ୍ରତିକୂଳରେ 240 km ଯିବା ପାଇଁ  30 ଘଣ୍ଟା ସମୟ ନିଅନ୍ତି କିନ୍ତୁ ସେହି ସମାନ ଦୂରତା
ସ୍ରୋତର ଅନୁକୂଳରେ ଅତିକ୍ରମ କରିବା ପାଇଁ  ମାତ୍ର 24 ଘଣ୍ଟା ସମୟ ନିଅନ୍ତି । ସ୍ରୋତର ବେଗ କେତେ?

Ans A. 1 km/hr

B. 4 km/hr

C. 2 km/hr

D. 3 km/hr

Question Type : MCQ
Question ID : 441009146995
Option 1 ID : 441009583793
Option 2 ID : 441009583796
Option 3 ID : 441009583794
Option 4 ID : 441009583795

Status : Answered
Chosen Option : C

Q.15 ରାଜୀବ ବାର୍ଷିକ ଭାବରେ ଚକ୍ରବୃଦ୍ଧି ହେଉଥିବା ଚକ୍ରବୃଦ୍ଧି ସୁଧ ହାରରେ ପୁଞ୍ଜି  ବିନିଯୋଗ କରି 5 ବର୍ଷରେ ନିଜ
ନିବେଶର ଦୁଇ ଗୁଣ ରାଶି ପ୍ରାପ୍ତ କରନ୍ତି । କେତେ ବର୍ଷରେ ସେହି ରାଶି ନିଜର ଚାରିଗୁ ଣ ହେବ?

Ans A. 10

B. 20

C. 19

D. 9

Question Type : MCQ
Question ID : 441009897825
Option 1 ID : 4410093545370
Option 2 ID : 4410093545372
Option 3 ID : 4410093545373
Option 4 ID : 4410093545371

Status : Answered
Chosen Option : A

Q.16 ଦୀପାବଳି ଉପଲକ୍ଷେ ଜଣେ ଦୋକାନୀ ଟେଲିଭିଜନ ସେଟ ଉପରେ କ୍ରମିକ ରିହାତି ପ୍ରଦାନ କରନ୍ତି । ଯଦି ଏକ
ଟେଲିଭିଜନ ସେଟର ଲିଖିତ ମୂଲ୍ୟ ₹16,000 ଏବଂ କ୍ରମିକ ରିହାତିଗୁ ଡିକ 25% ଏବଂ 35% ହୁଏ, ତେବେ ବିକ୍ରୟ
ମୂଲ୍ୟ ନିର୍ଣ୍ଣୟ କର ।

Ans A. ₹7,400

B. ₹7,600

C. ₹7,200

D. ₹7,800

Question Type : MCQ
Question ID : 441009929895
Option 1 ID : 4410093673537
Option 2 ID : 4410093673538
Option 3 ID : 4410093673536
Option 4 ID : 4410093673539

Status : Answered
Chosen Option : D
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Q.17 ଦୁଇଟି ସଂଖ୍ୟାର ଅନୁପାତ 3 : 5 ଅଟେ । ଯଦି ପ୍ରତ୍ୟେକ ସଂଖ୍ୟାରେ 8 ଯୋଗ କରାଯାଏ, ତେବେ ଅନୁପାତ 2 : 3
ହେବ । ସଂଖ୍ୟାଗୁଡ଼ିକ ନିର୍ଣ୍ଣୟ କର ।

Ans A. 24 ଏବଂ 30

B. 15 ଏବଂ 25

C. 18 ଏବଂ 30

D. 24 ଏବଂ 40

Question Type : MCQ
Question ID : 44100930453
Option 1 ID : 441009121310
Option 2 ID : 441009121308
Option 3 ID : 441009121309
Option 4 ID : 441009121311

Status : Answered
Chosen Option : B

Q.18 10 ଆଉନ୍ସ (ounces) ଓଜନର ଭିନେଗାର ଏବଂ ତେଲର ଏକ ମିଶ୍ରଣରେ ଭିନେଗାରର ପରିମାଣ 50% ଅଟେ
। ଏହି ମିଶ୍ରଣରେ କେତେ ଆଉନ୍ସ ତେଲ ମିଶାଇଲେ, ଭିନେଗାରର ପରିମାଣ 25% ହେବ?

Ans A. 10

B. 8

C. 15

D. 20

Question Type : MCQ
Question ID : 4410091607167
Option 1 ID : 4410096347646
Option 2 ID : 4410096347647
Option 3 ID : 4410096347645
Option 4 ID : 4410096347644

Status : Answered
Chosen Option : D

Q.19 ଗୋଟିଏ ଜେନେରେଟର 8 ଘଣ୍ଟାରେ 1,200 ୟୁ ନିଟ ବିଦ୍ୟୁତ ଶକ୍ତି  ଉତ୍ପନ୍ନ କରେ ଏବଂ ଏହି ସମୟରେ 20 ଲିଟର
ଇନ୍ଧନ ବ୍ୟବହାର କରେ । ଯଦି ଜେନେରେଟରଟି ସମାନ ଦକ୍ଷତାର ସହ ଚାଲେ, ତେବେ 1800 ୟୁ ନିଟ ବିଦ୍ୟୁତ
ଶକ୍ତି  ଉତ୍ପନ୍ନ କରିବା ପାଇଁ  ଏହା କେତେ ପରିମାଣର ଇନ୍ଧନ ବ୍ୟବହାର କରିବ?

Ans A. 35 ଲିଟର

B. 25 ଲିଟର

C. 30 ଲିଟର

D. 40 ଲିଟର

Question Type : MCQ
Question ID : 4410091452635
Option 1 ID : 4410095738916
Option 2 ID : 4410095738914
Option 3 ID : 4410095738915
Option 4 ID : 4410095738917

Status : Answered
Chosen Option : D
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Q.20 ନିମ୍ନଲିଖିତ ପରିପ୍ରକାଶକୁ ସରଳ କର ।

Ans A. 3.9

B. 6.7

C. 5.35

D. 2.86

Question Type : MCQ
Question ID : 441009257454
Option 1 ID : 4410091004018
Option 2 ID : 4410091004016
Option 3 ID : 4410091004017
Option 4 ID : 4410091004019

Status : Answered
Chosen Option : D

Q.21 ଭାରତୀୟ ଜନଗଣନା 2011 ଅନୁଯାୟୀ, ନିମ୍ନଲିଖିତ ରାଜ୍ୟଗୁଡ଼ିକ ମଧ୍ୟରୁ  କେଉଁ  ରାଜ୍ୟର ସାକ୍ଷରତା ହାର
ସର୍ବନିମ୍ନ ଥିଲା?

Ans A. ପଞ୍ଜାବ

B. ଉତ୍ତର ପ୍ରଦେଶ

C. ରାଜସ୍ଥାନ

D. ମଧ୍ୟ ପ୍ରଦେଶ

Question Type : MCQ
Question ID : 441009866480
Option 1 ID : 4410093418952
Option 2 ID : 4410093418953
Option 3 ID : 4410093418955
Option 4 ID : 4410093418954

Status : Answered
Chosen Option : B

Q.22 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟିକୁ ବୃହତ ଜଳବିଦ୍ୟୁତ ଡ୍ୟାମର ଏକ ଅସୁବିଧା ଭାବରେ ଚିହ୍ନଟ କରାଯାଇଛି?

Ans A. ସେଗୁଡିକ କୋଇଲା-ଭିତ୍ତିକ ଶକ୍ତି କେନ୍ଦ୍ର (coal-fired stations) ପରି ସମାନ ପରିମାଣର ଗ୍ରୀନହାଉସ ଗ୍ୟାସ ନିର୍ଗତ କରନ୍ତି ।

B. ସେଗୁଡ଼ିକ ସର୍ବଦା ଇମ୍ପୋଟେଡ ଟର୍ବାଇନ ଏବଂ ଜଟିଳ ଯନ୍ତ୍ରପାତିର ବ୍ୟବହାର ଆବଶ୍ୟକ କରନ୍ତି ।

C. ଆକାଶ ମେଘୁଆ ଥି ବା ସମୟରେ କିମ୍ବା  ଶୀତଋତୁ ରେ ସେଗୁଡ଼ିକ ବିଦ୍ୟୁତ ଶକ୍ତି ଉତ୍ପାଦନ କରିପାରନ୍ତି ନାହିଁ ।

D. ସେଗୁଡ଼ିକ ବାସସ୍ଥାନରେ ବ୍ୟାଘାତ ସୃଷ୍ଟି  କରନ୍ତି, ଜନସାଧାରଣଙ୍କୁ ବିସ୍ଥାପିତ କରନ୍ତି ଏବଂ ପଟୁ  ଜମିବା (silting) ଯୋଗୁଁ
ଜଳଭଣ୍ଡାରର ଆୟୁ ଷ ହ୍ରାସ କରନ୍ତି ।

Question Type : MCQ
Question ID : 4410091318425
Option 1 ID : 4410095205238
Option 2 ID : 4410095205241
Option 3 ID : 4410095205240
Option 4 ID : 4410095205239

Status : Answered
Chosen Option : A

Section : General Studies
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Q.23 1803 ମସିହା ଅକ୍ଟୋବର 14 ତାରିଖରେ ବାରବାଟୀ ଦୁର୍ଗ ଦଖଲ ପାଇଁ  ହୋଇଥିବା ଯୁଦ୍ଧରେ ବ୍ରିଟିଶମାନଙ୍କଠାରୁ
କେଉଁ  ଶାସନ ପରାସ୍ତ ହୋଇଥିଲା?

Ans A. ମରାଠା ସାମ୍ରାଜ୍ୟ

B. ହାଇଦ୍ରାବାଦର ନିଜାମ

C. ଫ୍ରେଞ୍ଚ ଇଷ୍ଟ ଇଣ୍ଡିଆ କମ୍ପାନୀ

D. ମୋଗଲ ସାମ୍ରାଜ୍ୟ

Question Type : MCQ
Question ID : 441009926777
Option 1 ID : 4410093661177
Option 2 ID : 4410093661178
Option 3 ID : 4410093661176
Option 4 ID : 4410093661175

Status : Answered
Chosen Option : C

Q.24 ଓଡ଼ିଶା ବଜେଟ 2026 –27 ରେ କେଉଁ  ନୂତନ ସହରାଞ୍ଚଳ ବିକାଶ ପଦକ୍ଷେପ ₹100 କୋଟି ପାଇଥିଲା?

Ans A. ରାଜ୍ୟ AI ମିଶନ

B. ଫି ଟ ଓଡିଶା ମିଶନ

C. ଟୁ ରିଜିମ ଲ୍ୟାଣ୍ଡ ବ୍ୟାଙ୍କ ସ୍କିମ

D. ମୁଖ୍ୟମନ୍ତ୍ରୀ ସ୍ମାର୍ଟ ସିଟି ମିଶନ

Question Type : MCQ
Question ID : 4410091864458
Option 1 ID : 4410097347176
Option 2 ID : 4410097347179
Option 3 ID : 4410097347178
Option 4 ID : 4410097347177

Status : Answered
Chosen Option : B

Q.25 ଭାରତୀୟ ସମ୍ବି ଧାନର ମୌଳିକ କର୍ତ୍ତବ୍ୟ ସନ୍ଦର୍ଭରେ ନିମ୍ନଲିଖିତ କେଉଁ  ବିବୃତିଟି ସଠିକ ନୁହେଁ ?

Ans A. ସେଗୁଡ଼ିକ ଭାରତୀୟ ସଂସ୍କୃ ତିର ସମ୍ମାନ ଏବଂ ସଂରକ୍ଷଣ ଉପରେ ଗୁରୁ ତ୍ୱାରୋପ କରନ୍ତି ।

B. ମୌଳିକ କର୍ତ୍ତବ୍ୟଗୁଡ଼ିକ ସ୍ୱଭାବତଃ ଉଭୟ ନାଗରିକ ଏବଂ ନୈତିକ ଅଟେ ।

C. ମୌଳିକ ଅଧି କାର ଏବଂ ମୌଳିକ କର୍ତ୍ତବ୍ୟ ମଧ୍ୟରେ ସ୍ପଷ୍ଟ ପାର୍ଥକ୍ୟ ରହିଛି ।

D. ସେଗୁଡ଼ିକ ନ୍ୟାୟିକ ଏବଂ ପ୍ରବର୍ତ୍ତନୀୟ ଅଟେ ।

Question Type : MCQ
Question ID : 441009633958
Option 1 ID : 4410092489978
Option 2 ID : 4410092489975
Option 3 ID : 4410092489976
Option 4 ID : 4410092489977

Status : Answered
Chosen Option : C
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Q.26 କଟକର ବାଲିଯାତ୍ରା, କେଉଁ  ଦେଶ/ଅଞ୍ଚଳ ସହିତ ଓଡ଼ିଶାର ଐତିହାସିକ ସାମୁଦ୍ରିକ ସମ୍ପର୍କକୁ ସ୍ମରଣ କରେ?

Ans A. ମଧ୍ୟ ଏସିଆରେ ସମରକନ୍ଦ, ବୁଖାରା ଏବଂ ତାସକେଣ୍ଟ

B. ଇଣ୍ଡୋନେସିଆରେ ଜାଭା, ସୁମାତ୍ରା ଏବଂ ବାଲି

C. ଆଫ୍ରି କାରେ ମୋମ୍ବା ସା, ଜାଞ୍ଜିବାର ଏବଂ ମାଡାଗାସ୍କର

D. ଜାପାନର ଓସାକା, କ୍ୟୋଟୋ ଏବଂ ନାଗାସାକି

Question Type : MCQ
Question ID : 4410091335144
Option 1 ID : 4410095272253
Option 2 ID : 4410095272254
Option 3 ID : 4410095272255
Option 4 ID : 4410095272256

Status : Answered
Chosen Option : A

Q.27 ନିକେଲ ଏବଂ ଲୁହାରେ ସମୃଦ୍ଧ ପୃଥିବୀର ସ୍ତର ପାଇଁ  କେଉଁ  ପଦ ବ୍ୟବହୃତ ହୁଏ?

Ans A. SIAL

B. NIFE

C. SIMA

D. NIIR

Question Type : MCQ
Question ID : 4410091843735
Option 1 ID : 4410097267881
Option 2 ID : 4410097267882
Option 3 ID : 4410097267883
Option 4 ID : 4410097267884

Status : Answered
Chosen Option : A

Q.28 2026 ମସିହା ପାଇଁ  ଓଡ଼ିଶାରୁ  ସାହିତ୍ୟ ଓ ଶିକ୍ଷା କ୍ଷେତ୍ରରେ କେତେଜଣ ବ୍ୟକ୍ତି  ପଦ୍ମଶ୍ରୀ ପୁରସ୍କାର ପାଇଁ  ମନୋନୀତ
ହୋଇଛନ୍ତି?

Ans A. 2

B. 1

C. 4

D. 3

Question Type : MCQ
Question ID : 4410091864436
Option 1 ID : 4410097347089
Option 2 ID : 4410097347088
Option 3 ID : 4410097347091
Option 4 ID : 4410097347090

Status : Answered
Chosen Option : C
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Q.29 ସର୍ବସାଧାରଣ ନିଯୁକ୍ତି  କ୍ଷେତ୍ରରେ ସୁଯୋଗର ସମାନତା (Equality of opportunity) ସମ୍ବନ୍ଧୀୟ ମୌଳିକ
ଅଧିକାର ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ଅନୁଚ୍ଛେଦରେ ବର୍ଣ୍ଣିତ?

Ans A. ଅନୁଚ୍ଛେଦ 16

B. ଅନୁଚ୍ଛେଦ 14

C. ଅନୁଚ୍ଛେଦ 15

D. ଅନୁଚ୍ଛେଦ 17

Question Type : MCQ
Question ID : 441009870517
Option 1 ID : 4410093435022
Option 2 ID : 4410093435020
Option 3 ID : 4410093435021
Option 4 ID : 4410093435023

Status : Answered
Chosen Option : C

Q.30 ଜୟପୁରଠାରେ 18 ଶତାବ୍ଦୀର ଶେଷ ଭାଗରେ ନିର୍ମିତ ନିମ୍ନଲିଖିତ କେଉଁ  ସ୍ମାରକୀ ଏହାର ବହୁ-ତଳ ବିଶିଷ୍ଟ
ସଂରଚନା (multi-storeyed structure) ଏବଂ ରାସ୍ତାରେ ଗତିବିଧି ନିରୀକ୍ଷଣ କରିବା ପାଇଁ  ଡିଜାଇନ
କରାଯାଇଥିବା ବିଶିଷ୍ଟ ଫେସେଡ (distinctive façade) ପାଇଁ  ଜଣାଶୁଣା ଅଟେ?

Ans A. ହାୱା ମହଲ

B. ଚାରମୀନାର

C. ତାଜମହଲ

D. ଲେହ ପ୍ୟାଲେସ

Question Type : MCQ
Question ID : 441009893182
Option 1 ID : 4410093526800
Option 2 ID : 4410093526801
Option 3 ID : 4410093526798
Option 4 ID : 4410093526799

Status : Answered
Chosen Option : A

Q.31 ଭାରତରେ 1857 ମସିହା ବିଦ୍ରୋହ ପରେ ଜାତି ଓ ଅଞ୍ଚଳ ଭିତ୍ତିରେ ରେଜିମେଣ୍ଟ ଗଠନ କରାଯାଇଥିଲା । ଏହି
ରଣନୀତିର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ କ’ଣ ଥିଲା?

Ans A. ସୈନ୍ୟବାହିନୀରେ ଅଧି କ ଲୋକଙ୍କୁ ନିଯୁକ୍ତ କରିବା

B. ସୈନିକମାନଙ୍କ ମଧ୍ୟରେ ଜାତୀୟ ଏକତାକୁ ରୋକିବା

C. ସୈନିକଙ୍କ ପ୍ରତି ବିଶ୍ୱସ୍ତତା ବିକାଶ କରିବା

D. ସୈନିକମାନଙ୍କର ବିଶ୍ୱାସ ଜିତିବା

Question Type : MCQ
Question ID : 4410091068329
Option 1 ID : 4410094218818
Option 2 ID : 4410094218817
Option 3 ID : 4410094218816
Option 4 ID : 4410094218815

Status : Answered
Chosen Option : B
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Q.32 ନିବେଶ ସୁଯୋଗ ବୃଦ୍ଧି ଲକ୍ଷ୍ୟରେ ଆୟୋଜିତ 'ପ୍ରୋଗ୍ରେସିଭ୍  ପଞ୍ଜାବ ଇନଭେଷ୍ଟର୍ସ ସମ୍ମିଟ 2026 ପଞ୍ଜାବର
ନିମ୍ନଲିଖିତ କେଉଁ  ସହରରେ ଅନୁଷ୍ଠି ତ ହୋଇଥିଲା?

Ans A. ମୋହାଲି

B. ଅମୃତସର

C. ଲୁଧି ଆନା

D. ଚଣ୍ଡିଗଡ଼

Question Type : MCQ
Question ID : 4410091836297
Option 1 ID : 4410097238872
Option 2 ID : 4410097238873
Option 3 ID : 4410097238871
Option 4 ID : 4410097238870

Status : Answered
Chosen Option : B

Q.33 ଗୁଜରାଟର ବେଲାବଦାର ଜାତୀୟ ଉଦ୍ୟାନ ______________ ସଂରକ୍ଷଣ ପାଇଁ  ପ୍ରସିଦ୍ଧ ।

Ans A. ବେଙ୍ଗଲ ଟାଇଗର

B. ଏସୀୟ ସିଂହ

C. ଭାରତୀୟ ପାଙ୍ଗୋଲିନ

D. କୃଷ୍ଣସାର ମୃଗ

Question Type : MCQ
Question ID : 441009978373
Option 1 ID : 4410093866134
Option 2 ID : 4410093866135
Option 3 ID : 4410093866137
Option 4 ID : 4410093866136

Status : Answered
Chosen Option : D

Q.34 ନିମ୍ନଲିଖିତ କେଉଁ ଟି କ୍ଲୋର-ଆଲକାଲି (chlor-alkali) ପ୍ରକ୍ରିୟାରେ ପ୍ରସ୍ତୁତ ହୁଏ?

Ans A. ସୋଡିୟମ ବାଇକାର୍ବୋନେଟ

B. ସୋଡିୟମ କ୍ଲୋରାଇଡ

C. ସୋଡିୟମ କାର୍ବୋନେଟ

D. ସୋଡିୟମ ହାଇଡ୍ରୋକ୍ସାଇଡ

Question Type : MCQ
Question ID : 4410091432234
Option 1 ID : 4410095657273
Option 2 ID : 4410095657272
Option 3 ID : 4410095657271
Option 4 ID : 4410095657270

Status : Answered
Chosen Option : D
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Q.35 କିଏ ଏକ ହୃଦୟସ୍ପର୍ଶୀ ବନ୍ଧୁତା କାହାଣୀ ବର୍ଣ୍ଣନା କରୁ ଥିବା କ୍ଷୁଦ୍ରଗଳ୍ପ କାବୁଲିୱାଲା ରଚନା କରିଛନ୍ତି?

Ans A. ମୁଲକ ରାଜ ଆନନ୍ଦ

B. ରବୀନ୍ଦ୍ରନାଥ ଟାଗୋର

C. ପ୍ରେମଚାନ୍ଦ

D. ଅନିତା ଦେସାଇ

Question Type : MCQ
Question ID : 4410091119670
Option 1 ID : 4410094414569
Option 2 ID : 4410094414566
Option 3 ID : 4410094414567
Option 4 ID : 4410094414568

Status : Answered
Chosen Option : D

Q.36 କେତେବେଳେ ଏକ ଉତ୍ତଳ ଲେନ୍ସ ଦ୍ୱାରା ଗଠିତ ପ୍ରତିବିମ୍ବ ବାସ୍ତବ ଏବଂ ଓଲଟା ହୋଇଥାଏ?

Ans A. ବସ୍ତୁଟି ଅନନ୍ତ ଦୂରତାରେ ଥି ବା ବେଳେ

B. ବସ୍ତୁଟି ଆଲୋକ କେନ୍ଦ୍ର (O) ଏବଂ ମୁଖ୍ୟ ଫୋକସ (F) ମଧ୍ୟରେ ଥି ବା ବେଳେ

C. ବସ୍ତୁଟି ଫୋକସ ଦୂରତା (2F) ର ଦୁଇଗୁଣ ଦୂରତା ବାହାରେ ଥି ବା ବେଳେ

D. ବସ୍ତୁଟି ମୁଖ୍ୟ ଫୋକସ (F) ରେ ଥି ବା ବେଳେ

Question Type : MCQ
Question ID : 4410091429927
Option 1 ID : 4410095648040
Option 2 ID : 4410095648041
Option 3 ID : 4410095648042
Option 4 ID : 4410095648043

Status : Answered
Chosen Option : B

Q.37 ଓଡିଶା କେଉଁ  ତିନୋଟି ପ୍ରମୁଖ ଖଣିଜ ପଦାର୍ଥ ଉତ୍ପାଦନରେ ଜାତୀୟ ସ୍ତରରେ ଅଗ୍ରଣୀ, ଯାହା ଏହାର ଭାରୀ ଶିଳ୍ପର
ମୂଳଦୁଆ ସୃଷ୍ଟି  କରେ?

Ans A. ହୀରା, ଚୂ ନପଥର, ପେଟ୍ରୋଲିୟମ୍

B. ଲୁହାପଥର, ବକ୍ସାଇଟ, କ୍ରୋମାଇଟ

C. ତମ୍ବା, ସୁନା, ଅଭ୍ର

D. ୟୁ ରାନିୟମ, ଗ୍ରାଫାଇଟ, ଟିଣ

Question Type : MCQ
Question ID : 4410091424532
Option 1 ID : 4410095626980
Option 2 ID : 4410095626982
Option 3 ID : 4410095626979
Option 4 ID : 4410095626981

Status : Answered
Chosen Option : A
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Q.38 ଜାନୁଆରୀ 2026 ରେ, ୟୁ ରୋ ମୁଦ୍ରା (euro currency) କୁ ଗ୍ରହଣ କରିବା ପରେ କେଉଁ  ଦେଶ ୟୁ ରୋଜୋନ
(Eurozone) ର 21 ତମ ସଦସ୍ୟ ହୋଇଥିଲା?

Ans A. ହଙ୍ଗେରି

B. ରୋମାନିଆ

C. ବୁଲଗେରିଆ

D. କ୍ରୋଏସିଆ

Question Type : MCQ
Question ID : 4410091859106
Option 1 ID : 4410097327233
Option 2 ID : 4410097327232
Option 3 ID : 4410097327231
Option 4 ID : 4410097327230

Status : Answered
Chosen Option : B

Q.39 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟି ପୂର୍ବଘାଟ ଉଚ୍ଚଭୂ ମି କୃଷି-ଜଳବାୟୁ  ଅଞ୍ଚଳ (Eastern Ghat High Land agro-
climatic zone) ର ଜଳବାୟୁ କୁ ସର୍ବୋତ୍ତମ ଭାବେ ବର୍ଣ୍ଣନା କରେ?

Ans A. ଥଣ୍ଡା ଏବଂ ଶୁଷ୍କ

B. ଉଷ୍ମ ଏବଂ ଆର୍ଦ୍ର

C. ଶୁଷ୍କ ଏବଂ ଗରମ (Arid and hot)

D. ହିମାୟନ (Freezing)

Question Type : MCQ
Question ID : 441009646070
Option 1 ID : 4410092538395
Option 2 ID : 4410092538396
Option 3 ID : 4410092538397
Option 4 ID : 4410092538398

Status : Answered
Chosen Option : C

Q.40 ମାର୍ଚ୍ଚ 2026 ରେ NYC ହାଫ-ମାରାଥନରେ 59 ମିନିଟ 42 ସେକେଣ୍ଡ ସମୟ ସହ ପୁରୁ ଷ ହାଫ-ମାରାଥନରେ
କେଉଁ  ଭାରତୀୟ ଆଥଲେଟ ଏକ ନୂତନ ଜାତୀୟ ରେକର୍ଡ ସ୍ଥାପନ କରିଥିଲେ?

Ans A. ମନୀଷ ଯାଦବ

B. ଗୁଲବୀର ସିଂ

C. ଅଜୟ କୁମାର

D. ସୁରେଶ ରେଡୀ

Question Type : MCQ
Question ID : 4410091835572
Option 1 ID : 4410097236032
Option 2 ID : 4410097236030
Option 3 ID : 4410097236031
Option 4 ID : 4410097236033

Status : Answered
Chosen Option : B
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Q.41 ନିମ୍ନଲିଖିତ କେଉଁ  ସମ୍ବି ଧାନ ସଂଶୋଧନ ଅଧିନିୟମ ଦ୍ୱାରା ଦଳବଦଳ ଭିତ୍ତିରେ ସଂସଦ ଏବଂ ରାଜ୍ୟ ବିଧାନସଭାର
ସଦସ୍ୟମାନଙ୍କୁ ଅଯୋଗ୍ୟ ଘୋଷଣା କରିବାର ବ୍ୟବସ୍ଥା କରାଯାଇଛି?

Ans A. 52 ତମ ସଂଶୋଧନ ଅଧି ନିୟମ

B. 53 ତମ ସଂଶୋଧନ ଅଧି ନିୟମ

C. 54 ତମ ସଂଶୋଧନ ଅଧି ନିୟମ

D. 55 ତମ ସଂଶୋଧନ ଅଧି ନିୟମ

Question Type : MCQ
Question ID : 44100946942
Option 1 ID : 441009186904
Option 2 ID : 441009186903
Option 3 ID : 441009186905
Option 4 ID : 441009186906

Status : Answered
Chosen Option : A

Q.42 ମାର୍ଚ୍ଚ 2026 ରେ ମହିଳା ଓ ଶିଶୁଙ୍କ ପାଇଁ  ଜିଲ୍ଲାଗୁଡ଼ିକୁ ଅଧିକ ନିରାପଦ କରିବା ଲକ୍ଷ୍ୟରେ ନିମ୍ନଲିଖିତ କେଉଁ  ରାଜ୍ୟ
"ଅପରେସନ୍ ଚିନ୍ନାରୀ ଥାଲ୍ଲୀ" (Operation Chinnari Thalli) ଏକ ସଚେତନତା କାର୍ଯ୍ୟକ୍ରମ ଆୟୋଜନ
କରିଥିଲା?

Ans A. ଗୁଜୁରାଟ

B. ଆନ୍ଧ୍ରପ୍ରଦେଶ

C. ପଶ୍ଚିମବଙ୍ଗ

D. ତାମିଲନାଡୁ

Question Type : MCQ
Question ID : 4410091841038
Option 1 ID : 4410097257352
Option 2 ID : 4410097257349
Option 3 ID : 4410097257350
Option 4 ID : 4410097257351

Status : Answered
Chosen Option : D

Q.43 ମାନବ ଶରୀରର କେଉଁ  ଅଂଶରେ ଖାଦ୍ୟର ସର୍ବାଧିକ ପାଚନ କ୍ରିୟା ଏବଂ ଅବଶୋଷଣ ହୋଇଥାଏ?

Ans A. କ୍ଷୁଦ୍ରାନ୍ତ୍ର

B. ପାଟି

C. ପାକସ୍ଥଳୀ

D. ବୃହଦନ୍ତ୍ର

Question Type : MCQ
Question ID : 4410091454234
Option 1 ID : 4410095745250
Option 2 ID : 4410095745252
Option 3 ID : 4410095745249
Option 4 ID : 4410095745251

Status : Answered
Chosen Option : C
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Q.44 ଦାରିଦ୍ର୍ୟ ପ୍ରତି ସୁଭେଦ୍ୟତା (vulnerability) କହିଲେ କ’ଣ ବୁଝ?

Ans A. କେବଳ ଆୟ ସ୍ତର ଆଧାରରେ ଦାରିଦ୍ର୍ୟତାର ବର୍ଗୀକରଣ

B. ଦାରିଦ୍ର୍ୟ ଆଡକୁ ଅଧି କ ଅଗ୍ରସର ହେବା କିମ୍ବା  ଦାରିଦ୍ର୍ୟରେ ରହିଯିବାର ଅଧି କ ସମ୍ଭାବନା

C. ଦାରିଦ୍ର୍ୟ ସୀମାରେଖା ତଳେ ଜୀବନଯାପନର ଏକ ସ୍ଥାୟୀ ସ୍ଥିତି

D. ଉପଭୋଗ ବ୍ୟୟ ମାଧ୍ୟମରେ ଦାରିଦ୍ର୍ୟତାର ମାପ

Question Type : MCQ
Question ID : 441009869118
Option 1 ID : 4410093429505
Option 2 ID : 4410093429504
Option 3 ID : 4410093429503
Option 4 ID : 4410093429506

Status : Answered
Chosen Option : C

Q.45 ଭାରତ ସରକାର ଅଧିନିୟମ 1919, ପୃଥକ ନିର୍ବାଚନ ମଣ୍ଡଳୀ ପ୍ରଦାନ କରି କେଉଁ  ସଂପ୍ରଦାୟର ପ୍ରତିନିଧିତ୍ୱ ନୀତିକୁ
ବିସ୍ତାର କରିଥିଲା?

Ans A. ଜୋରାଷ୍ଟ୍ରୀୟ, ବୌଦ୍ଧ ଏବଂ ୟୁ ରୋପର ଲୋକ

B. ବୌଦ୍ଧ, ଭାରତୀୟ ଖ୍ରୀଷ୍ଟିଆନ ଏବଂ ଜୈନ

C. ଆଙ୍ଗ୍ଲୋ-ଇଣ୍ଡିଆନ, ଜୈନ ଏବଂ ଦଳିତ ବର୍ଗ

D. ଶିଖ, ଭାରତୀୟ ଖ୍ରୀଷ୍ଟିଆନ ଏବଂ ଆଙ୍ଗ୍ଲୋ-ଇଣ୍ଡିଆନ

Question Type : MCQ
Question ID : 441009802231
Option 1 ID : 4410093163036
Option 2 ID : 4410093163035
Option 3 ID : 4410093163034
Option 4 ID : 4410093163037

Status : Answered
Chosen Option : C

Q.46 Complete the given sentence with the correct synonym of the underlined word.

The leader was highly appreciated for his magnanimous gesture towards the team;
he has always been known for being __________.

Ans A. honest

B. selfish

C. generous

D. creative

Question Type : MCQ
Question ID : 4410091832836
Option 1 ID : 4410097225344
Option 2 ID : 4410097225341
Option 3 ID : 4410097225342
Option 4 ID : 4410097225343

Status : Answered
Chosen Option : A

Section : English
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Q.47 Select the most appropriate option to substitute the underlined word segment in the
given sentence.

The manager considered him a/an person who is new to a field for this project.

Ans A. veteran

B. mentor

C. novice

D. expert

Question Type : MCQ
Question ID : 4410091817356
Option 1 ID : 4410097164843
Option 2 ID : 4410097164842
Option 3 ID : 4410097164844
Option 4 ID : 4410097164845

Status : Answered
Chosen Option : D

Q.48 Select the most appropriate meaning of the given proverb from the alternatives.

People who live in glass houses shouldn’t throw stones

Ans A. One should not criticize others if one has similar faults

B. People should avoid risky behaviour at home

C. Criticism is always harmful, even if deserved

D. Everyone should maintain transparency in their actions

Question Type : MCQ
Question ID : 441009411513
Option 1 ID : 4410091611442
Option 2 ID : 4410091611444
Option 3 ID : 4410091611445
Option 4 ID : 4410091611443

Status : Answered
Chosen Option : D

Q.49 Select the most appropriate option from the given alternatives to fill in the blank.

They usually ________ to the gym on weekends, but today they are at home.

Ans A. have gone

B. went

C. go

D. are going

Question Type : MCQ
Question ID : 4410091822849
Option 1 ID : 4410097186223
Option 2 ID : 4410097186222
Option 3 ID : 4410097186220
Option 4 ID : 4410097186221

Status : Answered
Chosen Option : D
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Q.50 Select the sentence in which the conjunction is used incorrectly.

Ans A. She wore a simple dress, yet she looked elegant.

B. The researcher worked carefully but the results were accurate.

C. Both the designer and the model attended the fashion show.

D. We can either take the train or drive to the mountains.

Question Type : MCQ
Question ID : 4410091794058
Option 1 ID : 4410097073984
Option 2 ID : 4410097073982
Option 3 ID : 4410097073983
Option 4 ID : 4410097073985

Status : Answered
Chosen Option : D

Q.51 Choose the correct indirect form of the following sentence.

He said, “I am hungry.”

Ans A. He said that he was hungry.

B. He told he was hungry

C. He said that he is hungry.

D. He said that he had been hungry.

Question Type : MCQ
Question ID : 4410091206356
Option 1 ID : 4410094758968
Option 2 ID : 4410094758969
Option 3 ID : 4410094758966
Option 4 ID : 4410094758967

Status : Answered
Chosen Option : B

Q.52 A sentence is divided into different segments. Rearrange all the segments to form a
coherent sentence.
(A) all the students gather in the / (B) playground before the classes start / (C) o’clock
every morning, and / (D) the school assembly begins at eight

Ans A. BDAC

B. ADCB

C. CDAB

D. DCAB

Question Type : MCQ
Question ID : 4410091823250
Option 1 ID : 4410097187794
Option 2 ID : 4410097187792
Option 3 ID : 4410097187795
Option 4 ID : 4410097187793

Status : Answered
Chosen Option : D
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Q.53 Identify the segment of the sentence that contains a grammatical error.
(P) The scientist / (Q) has wrote several reports / (R) on climate change / (S) for the
environmental journal.

Ans A. P

B. S

C. R

D. Q

Question Type : MCQ
Question ID : 4410091828561
Option 1 ID : 4410097208410
Option 2 ID : 4410097208413
Option 3 ID : 4410097208412
Option 4 ID : 4410097208411

Status : Answered
Chosen Option : C

Q.54 Choose the most appropriate synonym of the highlighted word to fill in the given
blank.

The man’s way of talking was pompous, and the party he threw was very ________.

Ans A. indifferent

B. hostile

C. grandiose

D. modest

Question Type : MCQ
Question ID : 4410091825160
Option 1 ID : 4410097194954
Option 2 ID : 4410097194951
Option 3 ID : 4410097194953
Option 4 ID : 4410097194952

Status : Answered
Chosen Option : C
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Q.55 Identify the grammatically incorrect part of the sentence and select the option that
correctly replaces it.
The tall building had a narrow entrance, bright windows, and a strongly security
guard at the front door.

Ans A. The tall building had a narrow entrance, choatic windows, and a strongly security guard at the front
door.

B. The tall building had a turbulent entrance, bright windows, and a strongly security guard at the
front door.

C. The swift building had a narrow entrance, bright windows, and a strongly security guard at the
front door.

D. The tall building had a narrow entrance, bright windows, and a vigilant security guard at the front
door.

Question Type : MCQ
Question ID : 4410091828335
Option 1 ID : 4410097207508
Option 2 ID : 4410097207507
Option 3 ID : 4410097207506
Option 4 ID : 4410097207509

Status : Answered
Chosen Option : C

Q.56 Identify the error in the following sentence and choose the option which rectifies it.

Do your brother likes to play basketball on weekends?

Ans A. Does your brother like to play basketball on weekends?

B. Does your brother likes to play basketball on weekends?

C. Did your brother likes to play basketball on weekends?

D. Do your brother like to play basketball on weekends?

Question Type : MCQ
Question ID : 4410091825092
Option 1 ID : 4410097194681
Option 2 ID : 4410097194680
Option 3 ID : 4410097194682
Option 4 ID : 4410097194679

Status : Answered
Chosen Option : B

Q.57 Select the most appropriate option that can substitute the underlined segment in the
given sentence.
His deep hatred and animosity towards his rivals consumed him.

Ans A. rancor

B. deceit

C. amity

D. forbearance

Question Type : MCQ
Question ID : 4410091829389
Option 1 ID : 4410097211654
Option 2 ID : 4410097211656
Option 3 ID : 4410097211653
Option 4 ID : 4410097211655

Status : Answered
Chosen Option : B
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Q.58 Select the option from the given alternatives that can be used as a one-word
substitute for the highlighted phrase.
Mahatma Gandhi was a person who does not believe in violence.

Ans A. nationalist

B. terrorist

C. activist

D. pacifist

Question Type : MCQ
Question ID : 4410091818953
Option 1 ID : 4410097171116
Option 2 ID : 4410097171114
Option 3 ID : 4410097171115
Option 4 ID : 4410097171117

Status : Answered
Chosen Option : A

Q.59 Select the option with the correct active voice usage.

Ans A. The students will have finish their projects every semester.

B. The students have finished their projects yesterday.

C. The students have been finishing their projects last week.

D. The students finish their projects every semester.

Question Type : MCQ
Question ID : 4410091828616
Option 1 ID : 4410097208632
Option 2 ID : 4410097208630
Option 3 ID : 4410097208633
Option 4 ID : 4410097208631

Status : Answered
Chosen Option : B

Q.60 Select the correct meaning of the idiom that can replace the underlined words.

The opposition leader tried to move the goalposts during the final phase of
negotiations.

Ans A. demand stricter conditions

B. challenge the authority

C. delay the talks intentionally

D. change the rules unfairly

Question Type : MCQ
Question ID : 4410091566454
Option 1 ID : 4410096187223
Option 2 ID : 4410096187222
Option 3 ID : 4410096187220
Option 4 ID : 4410096187221

Status : Answered
Chosen Option : D
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Comprehension:

Read the passage carefully and answer the questions that follow.

Deoxyribonucleic acid, commonly called DNA, contains the genetic instructions that control the
development and functioning of living organisms. DNA is present in the cells of almost all plants, animals,
and microorganisms. Its structure resembles a twisted ladder known as a double helix, a discovery that
transformed the study of biology. DNA is made of chemical units called nucleotides, which carry coded
information arranged in precise sequences. These sequences instruct cells to produce proteins that
perform essential tasks in the body, such as building tissues and regulating biological processes. When
cells divide, DNA is copied so that each new cell receives the same genetic instructions. Scientists examine
DNA to understand heredity, genetic disorders, and the evolutionary relationships between species. Modern
technology also allows researchers to analyse DNA in medical diagnosis and forensic investigations.
Through these scientific advances, DNA has become central to understanding how traits are inherited and
how life continues from one generation to the next.

SubQuestion No : 61

Q.61 Select the option that best expresses the central theme of the passage.

Ans A. The chemical classification of biological molecules found in living cells.

B. The discovery of proteins and their contribution to body development.

C. The role of genetic material in controlling inheritance and cellular functions.

D. The technological methods used in modern medical and forensic science.

Question Type : MCQ
Question ID : 4410091819873
Option 1 ID : 4410097174757
Option 2 ID : 4410097174758
Option 3 ID : 4410097174756
Option 4 ID : 4410097174759

Status : Answered
Chosen Option : B
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Comprehension:

Read the passage carefully and answer the questions that follow.

Deoxyribonucleic acid, commonly called DNA, contains the genetic instructions that control the
development and functioning of living organisms. DNA is present in the cells of almost all plants, animals,
and microorganisms. Its structure resembles a twisted ladder known as a double helix, a discovery that
transformed the study of biology. DNA is made of chemical units called nucleotides, which carry coded
information arranged in precise sequences. These sequences instruct cells to produce proteins that
perform essential tasks in the body, such as building tissues and regulating biological processes. When
cells divide, DNA is copied so that each new cell receives the same genetic instructions. Scientists examine
DNA to understand heredity, genetic disorders, and the evolutionary relationships between species. Modern
technology also allows researchers to analyse DNA in medical diagnosis and forensic investigations.
Through these scientific advances, DNA has become central to understanding how traits are inherited and
how life continues from one generation to the next.

SubQuestion No : 62

Q.62 Select the option that identifies a fact stated in the passage.

Ans A. DNA disappears during the process of division

B. DNA has a structure called a double helix

C. DNA exists only in the cells of animals

D. DNA mainly stores energy for movement

Question Type : MCQ
Question ID : 4410091819874
Option 1 ID : 4410097174762
Option 2 ID : 4410097174761
Option 3 ID : 4410097174760
Option 4 ID : 4410097174763

Status : Answered
Chosen Option : D
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Comprehension:

Read the passage carefully and answer the questions that follow.

Deoxyribonucleic acid, commonly called DNA, contains the genetic instructions that control the
development and functioning of living organisms. DNA is present in the cells of almost all plants, animals,
and microorganisms. Its structure resembles a twisted ladder known as a double helix, a discovery that
transformed the study of biology. DNA is made of chemical units called nucleotides, which carry coded
information arranged in precise sequences. These sequences instruct cells to produce proteins that
perform essential tasks in the body, such as building tissues and regulating biological processes. When
cells divide, DNA is copied so that each new cell receives the same genetic instructions. Scientists examine
DNA to understand heredity, genetic disorders, and the evolutionary relationships between species. Modern
technology also allows researchers to analyse DNA in medical diagnosis and forensic investigations.
Through these scientific advances, DNA has become central to understanding how traits are inherited and
how life continues from one generation to the next.

SubQuestion No : 63

Q.63 Select the option that best connects the passage to real-life situations.

Ans A. Detectives using genetic evidence to identify suspects in investigations

B. Engineers designing machines to improve production in factories

C. Farmers selecting crops suitable for cultivation in different seasons

D. Musicians composing melodies and performing songs during concerts

Question Type : MCQ
Question ID : 4410091819875
Option 1 ID : 4410097174765
Option 2 ID : 4410097174766
Option 3 ID : 4410097174764
Option 4 ID : 4410097174767

Status : Answered
Chosen Option : B
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Comprehension:

Read the passage carefully and answer the questions that follow.

Deoxyribonucleic acid, commonly called DNA, contains the genetic instructions that control the
development and functioning of living organisms. DNA is present in the cells of almost all plants, animals,
and microorganisms. Its structure resembles a twisted ladder known as a double helix, a discovery that
transformed the study of biology. DNA is made of chemical units called nucleotides, which carry coded
information arranged in precise sequences. These sequences instruct cells to produce proteins that
perform essential tasks in the body, such as building tissues and regulating biological processes. When
cells divide, DNA is copied so that each new cell receives the same genetic instructions. Scientists examine
DNA to understand heredity, genetic disorders, and the evolutionary relationships between species. Modern
technology also allows researchers to analyse DNA in medical diagnosis and forensic investigations.
Through these scientific advances, DNA has become central to understanding how traits are inherited and
how life continues from one generation to the next.

SubQuestion No : 64

Q.64 Select the option that identifies the tone of the passage.

Ans A. Humorous

B. Critical

C. Informative

D. Pessimistic

Question Type : MCQ
Question ID : 4410091819876
Option 1 ID : 4410097174769
Option 2 ID : 4410097174768
Option 3 ID : 4410097174770
Option 4 ID : 4410097174771

Status : Answered
Chosen Option : B
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Comprehension:

Read the passage carefully and answer the questions that follow.

Deoxyribonucleic acid, commonly called DNA, contains the genetic instructions that control the
development and functioning of living organisms. DNA is present in the cells of almost all plants, animals,
and microorganisms. Its structure resembles a twisted ladder known as a double helix, a discovery that
transformed the study of biology. DNA is made of chemical units called nucleotides, which carry coded
information arranged in precise sequences. These sequences instruct cells to produce proteins that
perform essential tasks in the body, such as building tissues and regulating biological processes. When
cells divide, DNA is copied so that each new cell receives the same genetic instructions. Scientists examine
DNA to understand heredity, genetic disorders, and the evolutionary relationships between species. Modern
technology also allows researchers to analyse DNA in medical diagnosis and forensic investigations.
Through these scientific advances, DNA has become central to understanding how traits are inherited and
how life continues from one generation to the next.

SubQuestion No : 65

Q.65 Select the synonym of the word “examine” as used in the passage.

Ans A. Produce

B. Discover

C. Understand

D. Analyse

Question Type : MCQ
Question ID : 4410091819877
Option 1 ID : 4410097174775
Option 2 ID : 4410097174774
Option 3 ID : 4410097174773
Option 4 ID : 4410097174772

Status : Answered
Chosen Option : D

Q.66 ସେ ______ ଶୀଘ୍ର ଟାଇପ୍ କରିପାରିବେ।

Ans A. ଅତିକମ

B. ବହୁତ

C. କମ

D. ଯଥେଷ୍ଟ

Question Type : MCQ
Question ID : 4410091675675
Option 1 ID : 4410096611531
Option 2 ID : 4410096611528
Option 3 ID : 4410096611529
Option 4 ID : 4410096611530

Status : Answered
Chosen Option : B

Section : Odia
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Q.67 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।

ସମୁଦ୍ର

Ans A. ସମୀର

B. ଶଶାଙ୍କ

C. ସାଗର

D. ନଭଃ

Question Type : MCQ
Question ID : 4410091080869
Option 1 ID : 4410094260693
Option 2 ID : 4410094260692
Option 3 ID : 4410094260691
Option 4 ID : 4410094260690

Status : Answered
Chosen Option : C

Q.68 ରାମ୍ପିବା କ୍ରିୟାର ପ୍ରେରଣାର୍ଥକ ରୂ ପ ହେଉଛି ______ ।

Ans A. ରୁ ମ୍ପିବା

B. ରୁ ମ୍ପାଇବା

C. ରେମ୍ପିବା

D. ରମ୍ପାଇବା

Question Type : MCQ
Question ID : 4410091448107
Option 1 ID : 4410095720916
Option 2 ID : 4410095720919
Option 3 ID : 4410095720917
Option 4 ID : 4410095720918

Status : Answered
Chosen Option : B

Q.69 ନିମ୍ନଲିଖିତ ବିକଳ୍ପଗୁଡ଼ିକ ମଧ୍ୟରୁ  ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସଠିକ୍ ଇଂରାଜୀ ଅନୁବାଦ ବାଛନ୍ତୁ:
ସରକାର ନୂତନ କରନୀତି ଘୋଷଣା କରିଛି।

Ans A. The bank has reduced the interest rate.

B. The government has approved a new law.

C. The budget has been passed in the Parliament.

D. The government has announced a new tax policy.

Question Type : MCQ
Question ID : 4410091201807
Option 1 ID : 4410094741009
Option 2 ID : 4410094741010
Option 3 ID : 4410094741011
Option 4 ID : 4410094741008

Status : Answered
Chosen Option : D
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Q.70 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ସତ

Ans A. ପୂଜା

B. ସତ୍ୟ

C. ମିଥ୍ୟା

D. ଧର୍ମ

Question Type : MCQ
Question ID : 4410091676161
Option 1 ID : 4410096613467
Option 2 ID : 4410096613466
Option 3 ID : 4410096613464
Option 4 ID : 4410096613465

Status : Answered
Chosen Option : B

Q.71 କିଛି ଶବ୍ଦ ଭୁ ଲ ଲେଖା ହୋଇଥିବା ଏକ ବାକ୍ୟ ଦିଆଯାଇଛି। ବିକଳ୍ପ ଗୁଡିକରୁ  ଗୋଟିଏ ବାଛନ୍ତୁ, ଯେଉଁ ଥିରେ
କୌଣସି ବନାନ ତ୍ରୁଟି ନାହିଁ।

ବ୍ରିଟିଶ ମାନଙ୍କ ବ୍ୟବହାର ଭାରତୀୟ ମାନଙ୍କ ମନରେ ଅସନ୍ତୋଷ ସୃଷ୍ଟି  କରୁ ଥିଲା।

Ans A. ବ୍ରିଟିସ ମାନଙ୍କ ବ୍ୟବହାର ଭାରତିୟ ମାନଙ୍କ ମନରେ ଅଶନ୍ତୋଷ ଶୃଷ୍ଟି  କରୁ ଥି ଲା।

B. ବ୍ରିଟିଶ ମାନଙ୍କ ବ୍ୟବହାର ଭାରତୀୟ ମାନଙ୍କ ମନରେ ଅସନ୍ତୋଷ ସୃଷ୍ଟି  କରୁ ଥି ଲା।

C. ବ୍ରିଟିଶ ମାନଙ୍କ ବ୍ୟବହାର ଭାରତିୟ ମାନଙ୍କ ମନରେ ଅଷନ୍ତୋଷ ସୃଷ୍ଟି  କରୁ ଥି ଲା।

D. ବ୍ରିଟିଷ ମାନଙ୍କ ବ୍ୟବହାର ଭାରତୀୟ ମାନଙ୍କ ମନରେ ଅସନ୍ତୋଷ ସୃଷ୍ଟି  କରୁ ଥି ଲା।

Question Type : MCQ
Question ID : 4410091236254
Option 1 ID : 4410094878600
Option 2 ID : 4410094878598
Option 3 ID : 4410094878599
Option 4 ID : 4410094878597

Status : Answered
Chosen Option : B

Q.72 ମୁଁ  ସେହି ଚଳଚ୍ଚିତ୍ରଟି ______ ଦେଖିଛି ।

Ans A. ପୂର୍ବରୁ

B. ଆସନ୍ତାକାଲି

C. ପରେ

D. ଶୀଘ୍ର

Question Type : MCQ
Question ID : 4410091675754
Option 1 ID : 4410096611852
Option 2 ID : 4410096611855
Option 3 ID : 4410096611853
Option 4 ID : 4410096611854

Status : Answered
Chosen Option : A
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Q.73 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ସମାନାର୍ଥକ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
ସୁକୃତ

Ans A. ପୂଣ୍ୟ

B. ଆରତୀ

C. କାର୍ଯ୍ୟ

D. ମନ୍ଦିର

Question Type : MCQ
Question ID : 4410091676226
Option 1 ID : 4410096613725
Option 2 ID : 4410096613724
Option 3 ID : 4410096613727
Option 4 ID : 4410096613726

Status : Answered
Chosen Option : C

Q.74 ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।

ସରକାର ଗରିବ ଲୋକମାନଙ୍କୁ ସବୁ କ୍ଷେତ୍ରରେ ସୁବିଧା ଯୋଗାଇ ଦେଉଛନ୍ତି।

Ans A. The government is providing facilities to the poor people in all fields.

B. The government was providing facilities to the poor in all fields.

C. The government will provide facilities to the poor in all fields.

D. The government will be providing facilities to the poor people.

Question Type : MCQ
Question ID : 4410091232585
Option 1 ID : 4410094864064
Option 2 ID : 4410094864065
Option 3 ID : 4410094864066
Option 4 ID : 4410094864067

Status : Answered
Chosen Option : D

Q.75 ନିମ୍ନଲିଖିତ ବିକଳ୍ପମାନଙ୍କୁ ମଧ୍ୟରୁ  ଇଂରାଜୀ ବାକ୍ୟର ସଠିକ୍ ଓଡ଼ିଆ ଅନୁବାଦ ପସନ୍ଦ କରନ୍ତୁ:

The windmill generated electricity for the nearby villages.

Ans A. ପବନଚକ୍ର ପାଖପାଖି  ଗାଁ  ପାଇଁ  ପାଣି ଉତ୍ପାଦନ କଲା।

B. ପବନଚକ୍ର ପାଖପାଖି  ଗାଁ  ପାଇଁ  ଧାନ ଉତ୍ପାଦନ କଲା।

C. ପବନଚକ୍ର ପାଖପାଖି  ଗାଁ  ପାଇଁ  ତେଲ ଉତ୍ପାଦନ କଲା।

D. ପବନଚକ୍ର ପାଖପାଖି  ଗାଁ  ପାଇଁ  ବିଦ୍ୟୁତ ଉତ୍ପାଦନ କଲା।

Question Type : MCQ
Question ID : 4410091202259
Option 1 ID : 4410094742799
Option 2 ID : 4410094742800
Option 3 ID : 4410094742801
Option 4 ID : 4410094742798

Status : Answered
Chosen Option : D
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

“ଜଳ ସଞ୍ଚୟ” ଆଜିର ସବୁଠାରୁ  ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ପରିବେଶିକ ଅଭିଯାନ। ମାନବ ଜୀବନ ଜଳ ବିନା ଅସମ୍ଭବ। ଗ୍ରାମ ଓ ସହର—ଦୁଇଁ ଠିରେ ମଧ୍ୟ
ଜଳର ଆବଶ୍ୟକତା ଦିନକୁ ଦିନ ବଢ଼ୁଛି। କିନ୍ତୁ ଅତିରିକ୍ତ ବ୍ୟବହାର, ଅପଚୟ ଓ ଦୂଷଣ ଫଳରେ ଜଳ ସମ୍ପଦ ହ୍ରାସ ପାଉଛି।

ପୃଥି ବୀର ୭୦% ଅଂଶ ଜଳ ଥି ଲେ ମଧ୍ୟ ପିଏବା ଜଳ କେବଳ ୨.୫% ଅଛି। ଏହାର ମଧ୍ୟରୁ  ବହୁତ ଅଂଶ ହିମନଦ ଓ ଗଭୀର ଜଳସ୍ତରରେ
ରହିଛି। ତେଣୁ, ପାଣି ସଞ୍ଚୟ ଓ ସୁଚିତ ବ୍ୟବହାର ଅତ୍ୟାବଶ୍ୟକ। ଯେଉଁ ଠି ସମ୍ଭବ, ସେଠି ବର୍ଷାଜଳ ସଞ୍ଚୟ କରି ଭବିଷ୍ୟତ ପିଢ଼ି ପାଇଁ  ପାଣି
ରକ୍ଷା କରିବା ଉଚିତ।

ସ୍କୁ ଲ, କଲେଜ ଓ ସମାଜ ସଂସ୍ଥାମାନେ ଯଦି ଜଳ ସଞ୍ଚୟ ଅଭିଯାନ ଆରମ୍ଭ କରନ୍ତି, ତେବେ ଲୋକମାନଙ୍କ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିବ। ପ୍ରତିଟି
ଘରେ ପାଣି ଅପଚୟ ରୋକିବା, ଭାଙ୍ଗି ଥି ବା ନଳ ମରାମତି କରିବା ଓ ନଦୀ-ପୋଖରୀ ସଫା ରଖିବା ଏକ ନାଗରିକ ଦାୟିତ୍ୱ। ଆମେ ଆଜି ଯଦି
ପାଣି ସଞ୍ଚୟ କରିବାରେ ସଫଳ ହେବା, ତେବେ ଆଗାମୀ ପିଢ଼ି ପାଇଁ  ଜୀବନ ସଂରକ୍ଷିତ ହେବ।

SubQuestion No : 76

Q.76 ଅନୁଚ୍ଛେଦପାଇଁ  ସଠିକ ସାରାଂଶ ଚୟନ କର।

Ans A. ପାଣି ସଞ୍ଚୟ କେବଳ ସରକାରୀ କାମ।

B. ଜଳ ସଞ୍ଚୟ ମାନବ ଜୀବନ ପାଇଁ  ଆବଶ୍ୟକ ଓ ସଚେତନତା ଆବଶ୍ୟକ।

C. ମାନବ ମାତ୍ର ପାଣି ବ୍ୟବହାର କରିପାରେ ନାହିଁ।

D. ପୃଥି ବୀରେ କେବଳ ସମୁଦ୍ର ଅଛି।

Question Type : MCQ
Question ID : 4410091488543
Option 1 ID : 4410095880378
Option 2 ID : 4410095880375
Option 3 ID : 4410095880376
Option 4 ID : 4410095880377

Status : Answered
Chosen Option : B
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

“ଜଳ ସଞ୍ଚୟ” ଆଜିର ସବୁଠାରୁ  ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ପରିବେଶିକ ଅଭିଯାନ। ମାନବ ଜୀବନ ଜଳ ବିନା ଅସମ୍ଭବ। ଗ୍ରାମ ଓ ସହର—ଦୁଇଁ ଠିରେ ମଧ୍ୟ
ଜଳର ଆବଶ୍ୟକତା ଦିନକୁ ଦିନ ବଢ଼ୁଛି। କିନ୍ତୁ ଅତିରିକ୍ତ ବ୍ୟବହାର, ଅପଚୟ ଓ ଦୂଷଣ ଫଳରେ ଜଳ ସମ୍ପଦ ହ୍ରାସ ପାଉଛି।

ପୃଥି ବୀର ୭୦% ଅଂଶ ଜଳ ଥି ଲେ ମଧ୍ୟ ପିଏବା ଜଳ କେବଳ ୨.୫% ଅଛି। ଏହାର ମଧ୍ୟରୁ  ବହୁତ ଅଂଶ ହିମନଦ ଓ ଗଭୀର ଜଳସ୍ତରରେ
ରହିଛି। ତେଣୁ, ପାଣି ସଞ୍ଚୟ ଓ ସୁଚିତ ବ୍ୟବହାର ଅତ୍ୟାବଶ୍ୟକ। ଯେଉଁ ଠି ସମ୍ଭବ, ସେଠି ବର୍ଷାଜଳ ସଞ୍ଚୟ କରି ଭବିଷ୍ୟତ ପିଢ଼ି ପାଇଁ  ପାଣି
ରକ୍ଷା କରିବା ଉଚିତ।

ସ୍କୁ ଲ, କଲେଜ ଓ ସମାଜ ସଂସ୍ଥାମାନେ ଯଦି ଜଳ ସଞ୍ଚୟ ଅଭିଯାନ ଆରମ୍ଭ କରନ୍ତି, ତେବେ ଲୋକମାନଙ୍କ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିବ। ପ୍ରତିଟି
ଘରେ ପାଣି ଅପଚୟ ରୋକିବା, ଭାଙ୍ଗି ଥି ବା ନଳ ମରାମତି କରିବା ଓ ନଦୀ-ପୋଖରୀ ସଫା ରଖିବା ଏକ ନାଗରିକ ଦାୟିତ୍ୱ। ଆମେ ଆଜି ଯଦି
ପାଣି ସଞ୍ଚୟ କରିବାରେ ସଫଳ ହେବା, ତେବେ ଆଗାମୀ ପିଢ଼ି ପାଇଁ  ଜୀବନ ସଂରକ୍ଷିତ ହେବ।

SubQuestion No : 77

Q.77 ଅନୁଚ୍ଛେଦର ମୁଖ୍ୟ ବିଷୟବସ୍ତୁକୁ ଚିହ୍ନଟ କର।

Ans A. ଶିକ୍ଷାର ମହତ୍ତ୍ୱ

B. ଗଛ ଲଗାଇବା

C. ଶିଳ୍ପୀକରଣ ଓ ବିକାଶ

D. ପାଣି ଅପଚୟ ରୋକିବା ଓ ସଞ୍ଚୟର ଆବଶ୍ୟକତା

Question Type : MCQ
Question ID : 4410091488544
Option 1 ID : 4410095880381
Option 2 ID : 4410095880380
Option 3 ID : 4410095880382
Option 4 ID : 4410095880379

Status : Answered
Chosen Option : D
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

“ଜଳ ସଞ୍ଚୟ” ଆଜିର ସବୁଠାରୁ  ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ପରିବେଶିକ ଅଭିଯାନ। ମାନବ ଜୀବନ ଜଳ ବିନା ଅସମ୍ଭବ। ଗ୍ରାମ ଓ ସହର—ଦୁଇଁ ଠିରେ ମଧ୍ୟ
ଜଳର ଆବଶ୍ୟକତା ଦିନକୁ ଦିନ ବଢ଼ୁଛି। କିନ୍ତୁ ଅତିରିକ୍ତ ବ୍ୟବହାର, ଅପଚୟ ଓ ଦୂଷଣ ଫଳରେ ଜଳ ସମ୍ପଦ ହ୍ରାସ ପାଉଛି।

ପୃଥି ବୀର ୭୦% ଅଂଶ ଜଳ ଥି ଲେ ମଧ୍ୟ ପିଏବା ଜଳ କେବଳ ୨.୫% ଅଛି। ଏହାର ମଧ୍ୟରୁ  ବହୁତ ଅଂଶ ହିମନଦ ଓ ଗଭୀର ଜଳସ୍ତରରେ
ରହିଛି। ତେଣୁ, ପାଣି ସଞ୍ଚୟ ଓ ସୁଚିତ ବ୍ୟବହାର ଅତ୍ୟାବଶ୍ୟକ। ଯେଉଁ ଠି ସମ୍ଭବ, ସେଠି ବର୍ଷାଜଳ ସଞ୍ଚୟ କରି ଭବିଷ୍ୟତ ପିଢ଼ି ପାଇଁ  ପାଣି
ରକ୍ଷା କରିବା ଉଚିତ।

ସ୍କୁ ଲ, କଲେଜ ଓ ସମାଜ ସଂସ୍ଥାମାନେ ଯଦି ଜଳ ସଞ୍ଚୟ ଅଭିଯାନ ଆରମ୍ଭ କରନ୍ତି, ତେବେ ଲୋକମାନଙ୍କ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିବ। ପ୍ରତିଟି
ଘରେ ପାଣି ଅପଚୟ ରୋକିବା, ଭାଙ୍ଗି ଥି ବା ନଳ ମରାମତି କରିବା ଓ ନଦୀ-ପୋଖରୀ ସଫା ରଖିବା ଏକ ନାଗରିକ ଦାୟିତ୍ୱ। ଆମେ ଆଜି ଯଦି
ପାଣି ସଞ୍ଚୟ କରିବାରେ ସଫଳ ହେବା, ତେବେ ଆଗାମୀ ପିଢ଼ି ପାଇଁ  ଜୀବନ ସଂରକ୍ଷିତ ହେବ।

SubQuestion No : 78

Q.78 ଗଦ୍ୟାଂଶପାଇଁ  ଉପଯୁକ୍ତ ଶୀର୍ଷକ ଚିହ୍ନଟ କର।

Ans A. ପାଣି ହେଉଛି ଜୀବନ

B. ଭାରତର ପରିବେଶ

C. ନଦୀ ଓ ପୋଖରୀ

D. ଜଳବାୟୁ  ପରିବର୍ତ୍ତନ

Question Type : MCQ
Question ID : 4410091488545
Option 1 ID : 4410095880383
Option 2 ID : 4410095880385
Option 3 ID : 4410095880384
Option 4 ID : 4410095880386

Status : Answered
Chosen Option : C

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

“ଜଳ ସଞ୍ଚୟ” ଆଜିର ସବୁଠାରୁ  ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ପରିବେଶିକ ଅଭିଯାନ। ମାନବ ଜୀବନ ଜଳ ବିନା ଅସମ୍ଭବ। ଗ୍ରାମ ଓ ସହର—ଦୁଇଁ ଠିରେ ମଧ୍ୟ
ଜଳର ଆବଶ୍ୟକତା ଦିନକୁ ଦିନ ବଢ଼ୁଛି। କିନ୍ତୁ ଅତିରିକ୍ତ ବ୍ୟବହାର, ଅପଚୟ ଓ ଦୂଷଣ ଫଳରେ ଜଳ ସମ୍ପଦ ହ୍ରାସ ପାଉଛି।

ପୃଥି ବୀର ୭୦% ଅଂଶ ଜଳ ଥି ଲେ ମଧ୍ୟ ପିଏବା ଜଳ କେବଳ ୨.୫% ଅଛି। ଏହାର ମଧ୍ୟରୁ  ବହୁତ ଅଂଶ ହିମନଦ ଓ ଗଭୀର ଜଳସ୍ତରରେ
ରହିଛି। ତେଣୁ, ପାଣି ସଞ୍ଚୟ ଓ ସୁଚିତ ବ୍ୟବହାର ଅତ୍ୟାବଶ୍ୟକ। ଯେଉଁ ଠି ସମ୍ଭବ, ସେଠି ବର୍ଷାଜଳ ସଞ୍ଚୟ କରି ଭବିଷ୍ୟତ ପିଢ଼ି ପାଇଁ  ପାଣି
ରକ୍ଷା କରିବା ଉଚିତ।

ସ୍କୁ ଲ, କଲେଜ ଓ ସମାଜ ସଂସ୍ଥାମାନେ ଯଦି ଜଳ ସଞ୍ଚୟ ଅଭିଯାନ ଆରମ୍ଭ କରନ୍ତି, ତେବେ ଲୋକମାନଙ୍କ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିବ। ପ୍ରତିଟି
ଘରେ ପାଣି ଅପଚୟ ରୋକିବା, ଭାଙ୍ଗି ଥି ବା ନଳ ମରାମତି କରିବା ଓ ନଦୀ-ପୋଖରୀ ସଫା ରଖିବା ଏକ ନାଗରିକ ଦାୟିତ୍ୱ। ଆମେ ଆଜି ଯଦି
ପାଣି ସଞ୍ଚୟ କରିବାରେ ସଫଳ ହେବା, ତେବେ ଆଗାମୀ ପିଢ଼ି ପାଇଁ  ଜୀବନ ସଂରକ୍ଷିତ ହେବ।

SubQuestion No : 79

Q.79 ଅନ୍ୟାନ୍ୟ ଉଦାହରଣରେ “ସଚେତନତା” ଶବ୍ଦର ସଠିକ୍ ବ୍ୟବହାର କର।

Ans A. ସଚେତନତା ଖାଇଲା।

B. ଜନସାଧାରଣ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିଲା।

C. ସଚେତନତା ରୋଗ ହେଲା।

D. ସଚେତନତା ଗଛ ଲଗାଏ।

Question Type : MCQ
Question ID : 4410091488546
Option 1 ID : 4410095880389
Option 2 ID : 4410095880387
Option 3 ID : 4410095880390
Option 4 ID : 4410095880388

Status : Answered
Chosen Option : B
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Comprehension:

ନିମ୍ନ  ଅନୁଚ୍ଛେଦଟିକୁ ପାଠ କରି ପ୍ରଦତ୍ତ ପ୍ରଶ୍ନଗୁଡ଼ିକର ଉତ୍ତର ଲେଖ।

“ଜଳ ସଞ୍ଚୟ” ଆଜିର ସବୁଠାରୁ  ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ପରିବେଶିକ ଅଭିଯାନ। ମାନବ ଜୀବନ ଜଳ ବିନା ଅସମ୍ଭବ। ଗ୍ରାମ ଓ ସହର—ଦୁଇଁ ଠିରେ ମଧ୍ୟ
ଜଳର ଆବଶ୍ୟକତା ଦିନକୁ ଦିନ ବଢ଼ୁଛି। କିନ୍ତୁ ଅତିରିକ୍ତ ବ୍ୟବହାର, ଅପଚୟ ଓ ଦୂଷଣ ଫଳରେ ଜଳ ସମ୍ପଦ ହ୍ରାସ ପାଉଛି।

ପୃଥି ବୀର ୭୦% ଅଂଶ ଜଳ ଥି ଲେ ମଧ୍ୟ ପିଏବା ଜଳ କେବଳ ୨.୫% ଅଛି। ଏହାର ମଧ୍ୟରୁ  ବହୁତ ଅଂଶ ହିମନଦ ଓ ଗଭୀର ଜଳସ୍ତରରେ
ରହିଛି। ତେଣୁ, ପାଣି ସଞ୍ଚୟ ଓ ସୁଚିତ ବ୍ୟବହାର ଅତ୍ୟାବଶ୍ୟକ। ଯେଉଁ ଠି ସମ୍ଭବ, ସେଠି ବର୍ଷାଜଳ ସଞ୍ଚୟ କରି ଭବିଷ୍ୟତ ପିଢ଼ି ପାଇଁ  ପାଣି
ରକ୍ଷା କରିବା ଉଚିତ।

ସ୍କୁ ଲ, କଲେଜ ଓ ସମାଜ ସଂସ୍ଥାମାନେ ଯଦି ଜଳ ସଞ୍ଚୟ ଅଭିଯାନ ଆରମ୍ଭ କରନ୍ତି, ତେବେ ଲୋକମାନଙ୍କ ମଧ୍ୟରେ ସଚେତନତା ବଢ଼ିବ। ପ୍ରତିଟି
ଘରେ ପାଣି ଅପଚୟ ରୋକିବା, ଭାଙ୍ଗି ଥି ବା ନଳ ମରାମତି କରିବା ଓ ନଦୀ-ପୋଖରୀ ସଫା ରଖିବା ଏକ ନାଗରିକ ଦାୟିତ୍ୱ। ଆମେ ଆଜି ଯଦି
ପାଣି ସଞ୍ଚୟ କରିବାରେ ସଫଳ ହେବା, ତେବେ ଆଗାମୀ ପିଢ଼ି ପାଇଁ  ଜୀବନ ସଂରକ୍ଷିତ ହେବ।

SubQuestion No : 80

Q.80 “ସଞ୍ଚୟ” ର ସମାନାର୍ଥବୋଧକ ଶବ୍ଦ

Ans A. ସଂରକ୍ଷଣ

B. ଅବହେଳା

C. ନାଶ

D. ଅପଚୟ

Question Type : MCQ
Question ID : 4410091488547
Option 1 ID : 4410095880391
Option 2 ID : 4410095880394
Option 3 ID : 4410095880392
Option 4 ID : 4410095880393

Status : Answered
Chosen Option : A

Q.81 If an organization is focusing on protecting web applications from SQL injection,
cross-site scripting and insecure APIs, which type of computer security is primarily
being addressed?

Ans A. Information security

B. Application security

C. Cloud security

D. Network security

Question Type : MCQ
Question ID : 4410091453589
Option 1 ID : 4410095742654
Option 2 ID : 4410095742653
Option 3 ID : 4410095742652
Option 4 ID : 4410095742651

Status : Answered
Chosen Option : B

Section : Computer
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Q.82 The standard alignment for the majority of documents is:

Ans A. Right align

B. Center align

C. Left align

D. Justify align

Question Type : MCQ
Question ID : 4410091425928
Option 1 ID : 4410095632302
Option 2 ID : 4410095632299
Option 3 ID : 4410095632301
Option 4 ID : 4410095632300

Status : Answered
Chosen Option : B

Q.83 ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟି ଏକ ସିଷ୍ଟମ ସଫ୍ଟୱେର ର ଉଦାହରଣ ନୁହେଁ ?

Ans A. ୟୁ ନିକ୍ସ

B. ଫେଡୋରା (Fedora)

C. ଉବୁଣ୍ଟୁ  (Ubuntu)

D. ମାଇକ୍ରୋସଫ୍ଟ  ୱାର୍ଡ

Question Type : MCQ
Question ID : 4410091439570
Option 1 ID : 4410095686947
Option 2 ID : 4410095686945
Option 3 ID : 4410095686946
Option 4 ID : 4410095686944

Status : Answered
Chosen Option : A

Q.84 Which option in most email clients such as Outlook or Gmail is used to automatically
check and correct spelling errors while typing an email?

Ans A. Activate Email Encryption

B. Turn on Spell Check or Auto-correct

C. Add Digital Signature

D. Enable Grammar Assistant

Question Type : MCQ
Question ID : 4410091459904
Option 1 ID : 4410095767792
Option 2 ID : 4410095767790
Option 3 ID : 4410095767791
Option 4 ID : 4410095767789

Status : Answered
Chosen Option : C
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Q.85 ଆପଣ MS ପାୱାରପଏଣ୍ଟ 365 ରେ ଏକ ନିର୍ଦ୍ଦିଷ୍ଟ Slide Master ଲେଆଉଟ ବ୍ୟବହାର କରୁ ଥିବା ସମସ୍ତ ସ୍ଲାଇଡ
ଡିଲିଟ କଲେ କ'ଣ ହୁଏ?

Ans A. ଲେଆଉଟ ଏକ ଥି ମରେ ରୂ ପାନ୍ତରିତ ହୋଇଯାଏ

B. ଲେଆଉଟ ମାଷ୍ଟର ଭିୟୁ ରେ ରହିଥାଏ

C. ଲେଆଉଟ ସେଭ କରିବା ପାଇଁ  ପାୱାରପଏଣ୍ଟ ପ୍ରମ୍ପଟ କରେ

D. ଲେଆଉଟ ଆପେଆପେ ରିମୁଭ ହୋଇଯାଏ

Question Type : MCQ
Question ID : 4410091449511
Option 1 ID : 4410095726507
Option 2 ID : 4410095726504
Option 3 ID : 4410095726506
Option 4 ID : 4410095726505

Status : Answered
Chosen Option : B

Q.86 ଏକ ନୂଆ ବ୍ଲାଙ୍କ ପ୍ରେଜେଣ୍ଟେସନ ଷ୍ଟାର୍ଟ କରିବା ପାଇଁ  କ'ଣ ସିଲେକ୍ଟ କରିବେ?

Ans A. Insert → New Slide

B. File → Open

C. File → New → Blank Presentation

D. View → Blank Slide

Question Type : MCQ
Question ID : 4410091448959
Option 1 ID : 4410095724305
Option 2 ID : 4410095724307
Option 3 ID : 4410095724304
Option 4 ID : 4410095724306

Status : Answered
Chosen Option : A

Q.87 କେଉଁ  ସଫ୍ଟୱେର ୟୁ ଜରଙ୍କୁ (ଲେଖିବା ଓ ଗଣନା) ରାଇଟିଂ ଏବଂ କାଲକୁଲେସନ ପରି ଟାସ୍କ ପରଫର୍ମ କରିବାକୁ
ସକ୍ଷମ କରିଥାଏ?

Ans A. ସିଷ୍ଟମ ୟୁ ଟିଲିଟି

B. କମ୍ପାଇଲର

C. ଅପରେଟିଂ ସିଷ୍ଟମ

D. ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର

Question Type : MCQ
Question ID : 4410091408276
Option 1 ID : 4410095562064
Option 2 ID : 4410095562062
Option 3 ID : 4410095562061
Option 4 ID : 4410095562063

Status : Not Answered
Chosen Option : --
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Q.88 କମ୍ପ୍ୟୁଟର ଭାଇରସ (Computer Virus) ପ୍ରସଙ୍ଗରେ, ସ୍ତମ୍ଭ A ରେ ଥିବା ବିଭିନ୍ନ ପ୍ରକାରର ଭାଇରସକୁ ସ୍ତମ୍ଭ B
ରେ ଥିବା ସେଗୁଡିକର ସଠିକ ବର୍ଣ୍ଣନା ସହିତ ମେଳ କର ।

ସ୍ତମ୍ଭ A - ଭାଇରସ
ପ୍ରକାର ସ୍ତମ୍ଭ B - ବର୍ଣ୍ଣନା

1. ୱର୍ମ (Worm) a) ଏକ ଡିସ୍କ କିମ୍ବା  ଡ୍ରାଇଭର ବୁଟ ଏରିଆ (boot area) କୁ ଇନଫେକ୍ଟ କରେ,
ଯାହା କମ୍ପ୍ୟୁଟରର ଷ୍ଟାର୍ଟଅପ ପ୍ରୋସେସରେ ବ୍ୟାଘାତ ଦିଏ ।

2. ଟ୍ରୋଜାନ ହର୍ସ (Trojan
Horse)

b) ଏକ ସେଲଫ-ରେପ୍ଲି କେଟିଙ୍ଗ ମାଲିସିଅସ ପ୍ରୋଗ୍ରାମ ଯାହା ୟୁ ଜରଙ୍କ
ଇଣ୍ଟରଏକଶନ ବିନା ନେଟୱାର୍କରେ ଅଟୋମାଟିକ ଭାବରେ ସ୍ପ୍ରେଡ ହେଇ ଥାଏ ।

3. ବୁଟ ସେକ୍ଟର ଭାଇରସ
(Boot Sector Virus)

c) ମାଲୱେର ଯିଏ ନିଜକୁ ଏକ ବୈଧ କାର୍ଯ୍ୟକ୍ରମ ଭାବେ ପ୍ରଦର୍ଶିତ କରି ୟୁ ଜରଙ୍କୁ
ଇନଷ୍ଟଲ କରିବା ପାଇଁ  ଟ୍ରିକ କରିଥାଏ ।

4. ଫାଇଲ ଇନଫେକଟର
ଭାଇରସ (File Infector
Virus)

d) ଏକ୍ସିକ୍ୟୁଟେବଲ ଫାଇଲଗୁଡ଼ିକ ସହିତ ଆଟାଚ ହୋଇଥାଏ ଏବଂ ଇନଫେକ୍ଟ
ଫାଇଲଗୁଡିକ ଓପନ କିମ୍ବା  ଏକ୍ସିକ୍ୟୁଟ କରିବା ସମୟରେ ଆକ୍ଟିଭେଟ ହୋଇଥାଏ ।

Ans A. 1–b, 2–d, 3–c, 4–a

B. 1–d, 2–b, 3–a, 4–c

C. 1–b, 2–c, 3–a, 4–d

D. 1–c, 2–a, 3–b, 4–d

Question Type : MCQ
Question ID : 4410091474009
Option 1 ID : 4410095823641
Option 2 ID : 4410095823642
Option 3 ID : 4410095823639
Option 4 ID : 4410095823640

Status : Not Answered
Chosen Option : --

Q.89 ସାଇବରସ୍ପେସରେ ସିକ୍ୟୁରିଟି କାହିଁକି ଗୁରୁ ତ୍ୱପୂର୍ଣ୍ଣ ଅଟେ?

Ans A. ଡାଟା ଟ୍ରାଫି କ ବଢାଇବା ପାଇଁ

B. କମ୍ପ୍ୟୁଟର ର କାର୍ଯ୍ୟଦକ୍ଷତା ହ୍ରାସ କରିବା ପାଇଁ

C. ଅଧି କ ସାଇବର ଥ୍ରେଟ କ୍ରିଏଟ କରିବା ପାଇଁ

D. ନିରାପଦ, ନୈତିକ ଏବଂ ନିର୍ଭରଯୋଗ୍ୟ ଅନଲାଇନ ଇଣ୍ଟରଆକ୍ସନ ସୁନିଶ୍ଚିତ କରିବା ପାଇଁ

Question Type : MCQ
Question ID : 4410091448949
Option 1 ID : 4410095724264
Option 2 ID : 4410095724266
Option 3 ID : 4410095724267
Option 4 ID : 4410095724265

Status : Not Answered
Chosen Option : --
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Q.90 ଏକ ସେୟାରଡ ୱାର୍କବୁକରେ ବିଭିନ୍ନ ୟୁ ଜରଙ୍କ ଦ୍ୱାରା କରାଯାଇଥିବା ଏଡିଟ ଗୁଡ଼ିକୁ ଟ୍ରାକ କରିବାପାଇଁ  MS Excel
365 ର କେଉଁ  ଫି ଚର ଆପଣଙ୍କୁ ସକ୍ଷମ କରିଥାଏ?

Ans A. Data Validation

B. Conditional Formatting

C. Comments

D. Track Changes (Legacy)

Question Type : MCQ
Question ID : 4410091447327
Option 1 ID : 4410095717936
Option 2 ID : 4410095717938
Option 3 ID : 4410095717935
Option 4 ID : 4410095717937

Status : Not Answered
Chosen Option : --

Q.91 ଫର୍ମୁ ଲା =A1*B1 ର ଅର୍ଥ କ'ଣ ଅଟେ?

Ans A. A1 କୁ B1 ଦ୍ୱାରା ଭାଗ କରିବା

B. A1 ଓ B1 କୁ ଗୁଣନ କରିବା

C. A1 ରୁ  B1 କୁ ବିୟୋଗ କରିବା

D. A1 ଓ B1 ଯୋଗ କରିବା

Question Type : MCQ
Question ID : 4410091446490
Option 1 ID : 4410095714630
Option 2 ID : 4410095714632
Option 3 ID : 4410095714633
Option 4 ID : 4410095714631

Status : Not Answered
Chosen Option : --
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Q.92 କଣ୍ଟେଣ୍ଟ ଫର୍ମାଟିଙ୍ଗ ପରିପ୍ରେକ୍ଷୀରେ, MS ୱାର୍ଡ 2021 ର ନିମ୍ନଲିଖିତ ବୈଶିଷ୍ଟଗୁଡିକୁ ସେଗୁଡିକର ସଠିକ ବର୍ଣ୍ଣନା
ସହିତ ମେଳ କର ।

ସ୍ତମ୍ଭ A
(ବୈଶିଷ୍ଟ) ସ୍ତମ୍ଭ B (ବର୍ଣ୍ଣନା)

1. Page
Orientation

a) ପେଜ ର ଟେକ୍ସଟ ଏବଂ ଏଜ (edges) ଗୁଡିକ ମଧ୍ୟରେ ଦୂରତା ନିର୍ଦ୍ଦିଷ୍ଟ କରେ ।

2. Page Size b) ୟୁ ଜରଙ୍କୁ ଭର୍ଟିକାଲ (ପୋର୍ଟ୍ରେଟ) ଏବଂ ହରିଜୋଣ୍ଟାଲ (ଲ୍ୟାଣ୍ଡସ୍କେପ) ଲେଆଉଟ ମଧ୍ୟରେ
ପରିବର୍ତ୍ତନ କରିବାକୁ ସକ୍ଷମ କରେ ।

3. Margins c) A4, ଲେଟର କିମ୍ବା  ଲିଗାଲ ପରି ଓଭରଅଲ ପେଜ ର ଡାଇମେନସନ ନିର୍ଦ୍ଧାରଣ କରେ ।

4. Page
Borders

d) ପେଜରେ ଥି ବା କଣ୍ଟେଣ୍ଟ ଚାରିପାଖରେ ଏକ ଡେକୋରେଟିଭ ଫ୍ରେମ କିମ୍ବା  ଆଉଟଲାଇନ
ପ୍ରୟୋଗ କରେ ।

Ans A. 1 → a, 2 → b, 3 → d, 4 → c

B. 1 → b, 2 → c, 3 → a, 4 → d

C. 1 → b, 2 → d, 3 → a, 4 → c

D. 1 → c, 2 → a, 3 → b, 4 → d

Question Type : MCQ
Question ID : 4410091467971
Option 1 ID : 4410095799714
Option 2 ID : 4410095799713
Option 3 ID : 4410095799716
Option 4 ID : 4410095799715

Status : Not Answered
Chosen Option : --

Q.93 କମ୍ପ୍ୟୁଟର ସଫ୍ଟୱେର ସନ୍ଦର୍ଭରେ ସ୍ତମ୍ଭ A ରେ ଥିବା ସଫ୍ଟୱେର ବୈଶିଷ୍ଟ୍ୟଗୁଡ଼ିକୁ ସ୍ତମ୍ଭ B ରେ ଥିବା ସେଗୁଡିକର
ବର୍ଣ୍ଣନା ସହ ମେଳ କର:

ସ୍ତମ୍ଭ A ସ୍ତମ୍ଭ B
1. ସିଷ୍ଟମ ସଫ୍ଟୱେର a) ଏଡିଟିଂ କିମ୍ବା  ଗେମିଂ ଭଳି ନିର୍ଦ୍ଦିଷ୍ଟ ୟୁ ଜର ଟାସ୍କ ପାଇଁ  ଡିଜାଇନ କରାଯାଇଥି ବା

ପ୍ରୋଗ୍ରାମଗୁଡ଼ିକୁ ନେଇ ଗଠିତ

2. ଆପ୍ଲି କେସନ
ସଫ୍ଟୱେର

b) କମ୍ପ୍ୟୁଟର ହାର୍ଡୱେୟାର ମ୍ୟାନେଜ କରେ ଏବଂ ସାମଗ୍ରିକ ସିଷ୍ଟମ ଫଙ୍କସନ ତଦାରଖ କରେ

3. ଅପରେଟିଂ ସିଷ୍ଟମ c) ଏକ କୋର ସିଷ୍ଟମ ସଫ୍ଟୱେର ଯାହା କମ୍ପ୍ୟୁଟରର ବେସିକ ଅପରେସନକୁ ସପୋର୍ଟ କରେ
ଏବଂ କଣ୍ଟ୍ରୋଲ କରେ

4. ମିଡିଆ ପ୍ଲେୟାର d) ଏକ ଆପ୍ଲି କେସନ ସଫ୍ଟୱେର ଯାହା ଅଡିଓ ଏବଂ ଭିଡିଓ ଫାଇଲର ପ୍ଲେବ୍ୟାକରେ ସାହାଯ୍ୟ
କରେ

Ans A. 1-b, 2-a, 3-c, 4-d

B. 1-d, 2-c, 3-b, 4-a

C. 1-a, 2-c, 3-d, 4-b

D. 1-c, 2-b, 3-a, 4-d

Question Type : MCQ
Question ID : 4410091439197
Option 1 ID : 4410095685475
Option 2 ID : 4410095685477
Option 3 ID : 4410095685478
Option 4 ID : 4410095685476

Status : Not Answered
Chosen Option : --
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Q.94 MS ୱାର୍ଡ 2020 ରେ କେଉଁ  ଫି ଚର ଟେକ୍ସଟର ହରିଜଣ୍ଟାଲ ପ୍ଲେସମେଣ୍ଟ (left, center, right, justified) କୁ
ଆଡଜଷ୍ଟ କରିଥାଏ?

Ans A. Line Spacing

B. Page Layout

C. Text Alignment

D. Font Size

Question Type : MCQ
Question ID : 4410091447671
Option 1 ID : 4410095719292
Option 2 ID : 4410095719293
Option 3 ID : 4410095719290
Option 4 ID : 4410095719291

Status : Not Answered
Chosen Option : --

Q.95 ଡେସ୍କଟପ ବ୍ୟାକଗ୍ରାଉଣ୍ଡର କେଉଁ  ଫି ଟ ଅପସନ (fit option) ଗୋଟିଏ ଇମେଜକୁ ଏକାଧିକ ମନିଟର ଉପରେ
ସ୍ପାନ (span) କରିବାକୁ ସକ୍ଷମ କରେ?

Ans A. Span

B. Fill

C. Fit

D. Stretch

Question Type : MCQ
Question ID : 4410091450091
Option 1 ID : 4410095728874
Option 2 ID : 4410095728873
Option 3 ID : 4410095728872
Option 4 ID : 4410095728875

Status : Not Answered
Chosen Option : --

Q.96 MS ପାୱାରପଏଣ୍ଟ ଫର ଦି ୱେବ ରେ କାର୍ଯ୍ୟ କରିବା ସମୟରେ MS ପାୱାରପଏଣ୍ଟ ଫାଇଲଗୁଡ଼ିକର କ'ଣ ହୁଏ?

Ans A. ଡାଉନଲୋଡ ନହେବା ପର୍ଯ୍ୟନ୍ତ ଫାଇଲଗୁଡିକ ଟେମ୍ପୋରାରୀ ଭାବରେ ଷ୍ଟୋର ହୋଇ ରହିଥାଏ

B. ଫାଇଲଗୁଡ଼ିକ ଅଟୋମେଟିକ ଭାବେ OneDrive ରେ ସେଭ ହୋଇଥାଏ, ଯାହା ରିଅଲ-ଟାଇମ କୋଲାବୋରେସନ କୁ ସକ୍ଷମ
କରିଥାଏ

C. File > Save As କ୍ଲିକ କଲାପରେ ହିଁ ଫାଇଲଗୁଡିକ ସେଭ ହୋଇଥାଏ

D. ଏଡିଟିଂ ସରିବା ପରେ, ଫାଇଲଗୁଡ଼ିକୁ ମାନୁଆଲୀ ସେଭ କରିବା ଆବଶ୍ୟକ

Question Type : MCQ
Question ID : 4410091427904
Option 1 ID : 4410095640154
Option 2 ID : 4410095640153
Option 3 ID : 4410095640155
Option 4 ID : 4410095640152

Status : Not Answered
Chosen Option : --
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Q.97 ଆପଣଙ୍କ ଡାଟାକୁ ଏନକ୍ରିପ୍ଟ କରି ଏହାକୁ ଅନଲକ କରିବା ପାଇଁ  ଟଙ୍କା ମାଗୁଥିବା ଭାଇରସକୁ କ'ଣ କୁହାଯାଏ?

Ans A. ରାନ୍ସ ମୱେର (Ransomware)

B. ରୁ ଟକିଟ (Rootkit)

C. କୀଲଗର (Keylogger)

D. ଓର୍ମ (Worm)

Question Type : MCQ
Question ID : 4410091453297
Option 1 ID : 4410095741470
Option 2 ID : 4410095741472
Option 3 ID : 4410095741471
Option 4 ID : 4410095741469

Status : Not Answered
Chosen Option : --

Q.98 ଷ୍ଟାଣ୍ଡାର୍ଡ MS Excel ୱାର୍କସିଟ ସହିତ ସାଧାରଣତଃ କେଉଁ  ଫାଇଲ ଏକ୍ସଟେନସନ ଜଡ଼ିତ ଥାଏ?

Ans A. .txt

B. .docx

C. .pptx

D. .xlsx

Question Type : MCQ
Question ID : 4410091427831
Option 1 ID : 4410095639851
Option 2 ID : 4410095639848
Option 3 ID : 4410095639850
Option 4 ID : 4410095639849

Status : Not Answered
Chosen Option : --

Q.99 ଆଉଟଲୁକ 2021 ରେ ସ୍ପେଲିଙ୍ଗ ଏବଂ ଗ୍ରାମରର ପୁନଃଯାଞ୍ଚ ପାଇଁ  ଆପଣ କେଉଁ ଠି ଅପସନ ପାଇବେ?

Ans A. File → Options → Mail → Spelling and Autocorrect

B. Home → Mail → Grammar

C. Insert → Options → Proofing

D. Review > Spelling & Grammar.

Question Type : MCQ
Question ID : 4410091450809
Option 1 ID : 4410095731692
Option 2 ID : 4410095731694
Option 3 ID : 4410095731695
Option 4 ID : 4410095731693

Status : Not Answered
Chosen Option : --
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"

Q.100 ନିମ୍ନଲିଖିତ କେଉଁ  ଫାଇଲ ଏକ୍ସଟେନସନ ୱିଣ୍ଡୋଜ 11ରେ ଏକ ଏକ୍ସିକ୍ୟୁଟେବଲ ପ୍ରୋଗ୍ରାମ ଫାଇଲ (executable
program file) କୁ ପ୍ରତିନିଧିତ୍ୱ କରେ?

Ans A. .exe

B. .docx

C. .bmp

D. .csv

Question Type : MCQ
Question ID : 4410091438119
Option 1 ID : 4410095681170
Option 2 ID : 4410095681169
Option 3 ID : 4410095681172
Option 4 ID : 4410095681171

Status : Not Answered
Chosen Option : --
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